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Introduction

Welcome to the CA and CB Series of PC/104 communication modules, a multiport serial module for
industrial applications. It is designed for the PC/104 CPU and PC/104-Plus boards that respectively accept
the PC/104 and PC/104-Plus expansion interface. Optional DB9 and DB25 cables are available to connect
different devices.

The CA Series includes the following models:

CA-108: 8 ports, RS-232

CA-108-T: 8 ports, RS-232, wide temperature

CA-114: 4 ports, RS-232/422/485

CA-114-T: 4 ports, RS-232/422/485, wide temperature

CA-1341I: 4 ports, RS-422/485, optical isolation protection

CA-134I-T: 4 ports, RS-422/485, optical isolation protection, wide temperature
CA-104: 4 ports, RS-232

CA-104-T: 4 ports, RS-232, wide temperature

CA-132: 2 ports, RS-422/485

CA-132-T: 2 ports, RS-422/485, wide temperature

CA-132I: 2 ports, RS-422/485, optical isolation protection

CA-132I-T: 2 ports, RS-422/485, optical isolation protection, wide temperature

The CB Series includes the following models:

CB-108: 8 ports, RS-232

CB-108-T: 8 ports, RS-232, wide temperature

CB-114: 4 ports, RS-232/422/485

CB-114-T: 4 ports, RS-232/422/485, wide temperature

CB-1341I: 4 ports, RS-422/485, optical isolation protection

Cb-134I-T: 4 ports, RS-422/485, optical isolation protection, wide temperature

2 kV optical isolation is provided on optical isolation models. Wide-temperature models are rated for
operation between -40 to 85°C.

The following topics are covered in this chapter:

O Overview
O Package Checklist

O Product Specifications
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Overview

The PC/104 standard serial boards are very popular for embedded applications. Moxa offers a wide selection
of PC/104 and PC/104-Plus serial boards to provide industrial-grade connections to multiple serial devices.

Use Moxa's serial boards so that your PC/104-based systems can establish serial device connections with
high data throughput over multiple serial interfaces. The CA serial board series is for PC/104 modules, while
the CB serial board series is for PC/104-Plus modules.

Package Checklist

MOXA performs a careful mechanical and electrical inspection of each module prior to shipping. Your module
should arrive in perfect electrical order, free of any marks or scratches. Please handle the module by the
edges only, since your body’s static charge can damage the integrated circuits. When the module is not in
use, please keep it in the anti-static package provided. You may also use this package to return the module
if it requires repair.

The CA/CB Series module is shipped with the following items:
e Multiport serial module (PC/104 is for CA Series; PC/104-Plus is for CB Series)
e Documentation and software CD

e Quick installation guide

e 5-year product warranty statement

NOTE

Please notify your sales representative if any of the above items are missing or damaged.

The CA Series module features the following:

e Two, four, or eight serial ports (depending on the model)

e RS-232, RS-422, or RS-485 operation (depending on the model)
e 64-byte FIFOs and on-chip flow control

e Up to 921.6Kbps data transmission speed

e Built-in 15 KV ESD protection

e Configurable IRQ and I/O settings

e Onboard Tx, Rx LED indicators for each port

e Optional wide temperature support (-40 to 85°C)

The CB Series module features the following:

e Four or eight serial ports (depending on the model)

e RS-232, RS-422, or RS-485 operation (depending on the model)
e 128-byte FIFOs and on-chip flow control

e Up to 921.6Kbps data transmission speed

e Built-in 15 KV ESD protection

e Onboard Tx, Rx LED indicators for each port

e Optional wide temperature support (-40 to 85°C)
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Product Specifications

NOTE The latest specifications for Moxa’s products can be found at https://www.moxa.com.
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Hardware Installation

This chapter explains how to install the CA/CB Series multiport serial module.
The following topics are covered in this chapter:

O Hardware Installation

O Block Diagrams

I/O Base Address (For CA Series)
Rotary Switch (For CB Series)

Termination Resistor

YV V V VY

Interrupt Vector for CA Series

O Serial Interface
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Hardware Installation

Installing the CA/CB Series module is easy. For the CA Series, before inserting the module into the PC/104
slot, you must first configure the I/O base address, interrupt vector, IRQ, and serial interface (for select
models).

ATTENTION

Safety First!

To prevent damage to your system or board, make sure your embedded PC’s power is turned off before
installing your CA/CB Series module.

CA Series CB Series

Step 1: Shut off power to your embedded PC and |Step 1: Shut off power to your embedded PC and to
to any peripheral devices. After shutting any peripheral devices. After shutting off
off power, remove the cover of your power, remove the cover of your embedded
embedded PC. PC.

Step 2: Use the DIP switches on the module to Step 2: Use the DIP switches on the module to select
select the I/O base address, interrupt the serial interface. Details for each model
vector, IRQ, and serial interface (for are provided later in this chapter.
select models). Details for each model are | Step 3: Insert the module firmly into the embedded
provided later in this chapter. PC’s PC/104-Plus slot.

Step 3: Insert the module firmly into the Step 4: Screw the control board in place.
embedded PC’s PC/104 slot. Step 5: Connect the cables.

Step 4: Screw the control board in place Step 6: Power on the embedded PC. The BIOS will

Step 5: Connect the cables. automatically set the IRQ and I/O address.

Step 6: Power on the embedded PC. Step 7: Proceed with the software installation. Please

refer to Chapter 3.

Block Diagrams

CA-108

II.I_|

SW2: Interrupt Vector
SW1: I/0 Base Address

i— Box Header Connector (Ports 1 to 4)

Box Header Connector (Ports 5 to 8)

T . vy PC/104 Slot
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CA-114

1 SW3
Sw4 ] Serial Interface
I SW5

SW1: I/0 Base Address
SW2: Interrupt Vector
PC/104 Slot

Box Header Connector

LOpnngnnminogn |

]
1111

CA-1341, CA-132 , CA-1321

RS-422/RS-485
@[ @———— > \iRrE/4 WIRE
rala SW1: I/0O Base Address
SW2: Interrupt Vector
PC/104 Slot
Box Header Connector
20-pin for CA-132 V2, CA-1321 V2
40-pin for CA-134l

A

CA-104

F pegee
SW2: Interrupt Vector

SW1: I/O Base Address

i— Box Header Connector

PC/104 Slot

Rotary Switch
PC/104-Plus Slot

Box Header Connector (Ports 1 to 4)
Box Header Connector (Ports 5 to 8)

PC/104 Slot
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CB-114

Rotary switch

PC/104-Plus Slot

SWA1

— SW2 = Serial Interface
JP 3 SW3

Box Header Connector
PC/104 Slot

Rotary Switch
PC/104-Plus Slot
RS422/485
2-wire/4-wire

Box Header Connector
PC/104 Slot

I/0 Base Address (For CA Series)

Use DIP switch SW1 to set port 1’s I/O base address. The other ports will be configured automatically. The
default I/O base address is 0x180 and allows settings from 0x000 to O0x3FF. Some popular settings are
provided below:

A3 A4 A5 A6 A7 A8 A9
8 1 2 4 8 1 2 Hex

ON ON ON ON ON ON ON 0x000
ON ON ON ON ON ON off 0x200
ON ON ON ON ON off off 0x300
ON ON ON ON off off off 0x380
ON ON ON off off off off 0x3C0
ON ON off off off off off 0x3E0
ON off off off off off off 0x3F0
off off off off off off off 0x3F8
off ON ON ON ON ON ON 0x008
off off ON ON ON ON ON 0x018
off off off ON ON ON ON 0x038
off off off off ON ON ON 0x078
off off off off off ON ON 0xO0F8
off off off off off ON off 0x2F8

2-4
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For example, an I/O base address of 0x180 should be set as follows:

A3 A4 A5 A6 A7 A8 A9 Hex
ON ON ON ON off off ON 0x180
A3 A4 A5 A6 A7 A8 A9

q DIP

i aalal®®la

112 3 4 5|6 7

0 8 1 E=on,g=off

The other serial ports will be set automatically to 0x188, 0x190, 0x198, etc.

Rotary Switch (For CB Series)

A rotary switch on the board makes it easy to set the appropriate signals, particularly when installing
multiple PC/104-Plus modules in the same unit. The rotary switch, which looks like a clock, provides a
bidirectional path with no signal propagation delay. The first module on the stack should be set to CLKO, the
second to CLK1, etc., to eliminate clock skew between modules.

Termination Resistor

Onboard termination resistors can be activated individually for each serial port using jumpers. With regard
to the CA Series: for CA-114 and CA-134I, use JP1 through JP4; for CA-132 and CA-132I, use JP1 and JP2.
JP1 corresponds to serial port 1. For the CB Series, use jumpers JP1 through JP4. JP1 corresponds to serial
port 1. Short the jumper pins to activate the termination resistor; leave the jumper pins open to bypass the
termination resistor.

Interrupt Vector for CA Series

Use DIP switch SW2 to set port 1’s interrupt vector. The default interrupt vector is 0x1CO0, with SW2 set as

follows:
A3 A4 A5 A6 A7 A8 A9 Hex
ON ON ON off off off ON 0x1CO0
A3 A4 A5 A6 A7 A8 A9

Bk

0 c 1 H

on, H = off
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Serial Interface

CA Series

For the CA-114, use SW3, SW4, and SW5 to select the serial interface as follows:

ON DIP Sw3
1 2 3 4 — > PortNo.
4w 2w
Interface RS-232 RS-422
RS-485 RS-485 ON DIP Sw4

SW3 - - ON OFF E E E E
sSw4 - ON OFF OFF 1 2 3 4 —* PortNo.
SW5 ON OFF OFF OFF (o] DI SwW5

1 3

»[[A°
|

~ 12

[ Port No.

For the CA-1341, CA-132 , and CA-1321, use the 2-WIRE/4-WIRE and RS-422/RS-485 DIP switches to
select the serial interface as follows:

Interface 2-WIRE/4-WIRE RS-422/RS-485
RS-422 - OFF
4-wire RS-485 OFF ON
2-wire RS-485 ON ON
CB Series

For the CB-114 and CB-134I, use the DIP switch to select serial interface.

CB-114

Mode S1 S2 S3

RS-232 - - ON

RS-422 - ON OFF
4-wire RS-485 ON OFF OFF
2-wire RS-485 OFF OFF OFF
CB-1341

Mode S1 S2

RS-422 - OFF

4-wire RS-485 OFF ON

2-wire RS-485 ON ON

IRQ for CA Series

Before selecting an IRQ, please enter the PC’s BIOS and reserve a dedicated IRQ for the module. On the
module, the IRQ is set by a jumper. Before inserting the module into the PC/104 slot, use the jumper to
select an IRQ (3, 4, 5,6, 7,9, 10, 11, 12, or 15).

2-6
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Software Installation

After installing the CA/CB Series module in your embedded computer, the next step is installing the
software. Drivers for various operating systems are provided, including DOS, Windows, and Linux. This
chapter explains how to install and remove the CA/CB Series driver.

The following topics are covered in this chapter:

O Windows OS

» Older OS for CA Series

» Older OS for CB Series

» Newer OS for Both CA/CB Series
O Non-Windows OS
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Windows OS
Older OS for CA Series

DOS

Moxa DOS API-232 is a software package that can help you develop or debug serial communications
programs. This section will explain how to install the package, set up the driver, and load or unload the
driver. For additional information about the API-232 library and utilities, please refer to Chapter 4.

The DOS drivers support the CA-104, CA-104-T, CA-132, CA-132-T, CA-132I, and CA-132I-T. The CA-108,
CA-114, and CA-134I models are not supported under DOS.

In the following instructions, the CA-104 is used as an example.

Installing the Driver

Run the installation program, DOSINST.EXE, in the DOS folder. Specify the target directory for the API-232
files (e.g., C:\MOXA). Press F2 to start the installation.

A E S DA S AT N

FAESHe TR pirs bal L b o

When the installation is completed, you will be prompted to set up the board and driver initial values. We
strongly recommendthat you do so.
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Driver Setup

The following instructions are not intended to illustrate every function of the setup program. For more
detailed information, please refer to the help files by pressing F1 in the setup program.

1. Run the setup program BIN\SETUP.EXE.

2. Select your CA Series model and press Enter.

4 B 5

Pl Hooareol

r e beies i =

Fork wetig

3. You must set the Port No., I/O Address, IRQ, and INT Vector properly. These settings must match your
module’s hardware configuration.

s HATEE

RS N0 Beveans ol b e gy

FAH =t il SEwa Ear eyt Palm-Slort s

4. Press PgDn to view advanced the port setup options. Your module’s configuration will be displayed along
with other settings, such as port number, buffer size, etc.
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5. Verify the settings and make any necessary changes.

Porl Scbap

A He ] Phre Liroiip el ats  FAH b Ssave s Esne fihort

Port number: This is the port ID of each port. Application software will refer to a port by its
port number (ID). Port numbers must be unique; duplicated port numbers are
not allowed. The port ID can range from 0 to 127 as long as it does not overlap
with another port. Generally, you should consider the convenience of
programming when specifying the port number.

TxD buffer size: This is the transmission (output) buffer allocated in the system for each port.
RxD buffer size: This is the receiving (input) buffer allocated in the system for each port.
F5: Group Edit: This allows you to configure several ports simultaneously as a group.

SR hart

Errierhd
[ L b

6. Press F10 to save the latest configuration and exit the setup program.
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Loading the Driver

After setting up the driver, you must load the driver in order to gain access to the serial ports on the
module. Run BIN\DPC-DRV.EXE at the DOS prompt. The driver will detect your CA Series module
automatically. You should see messages indicating successful detection of your module, such as the
following:

PC/104 Communication Module DOS driver Version 1.0
Setup driver ...

CA-104 series OK!

Device driver setup O.K.

At this point, you can execute applications that support API-232 functions, or start developing applications
using the API-232 library.

Unloading the Driver

To unload or release the CA Series driver from memory, enter DPC-DRV/Q at the DOS prompt.

Windows NT

The Windows NT drivers conform to the Win32 COMM API standard and support the CA-104, CA-104-T, CA-
132, CA-132-T, CA-132I, CA-132I-T. CA-108, CA-114, and CA-134I.

In the following instructions, the CA-104 is used as an example.

Installing the Driver

1. Right-click Network Neighborhood and select Properties in the context menu.

Open
Explore
Find Computer. ..

K ap Metwark, Drive...
Dizzonnect Metwark Drive...

Create Shartcut
Rename

3-5
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Software Installation

2. Under the Adapters tab, click Add....

Network

Identif\catmnl Servicesl Protocols  Adapters | Bindingsl

Metwork Adapters:

[1]1D-Link DFE-530T PCl Fast Ethernet Adapter [Fev B)

Add... FRemaove Properties... Update

Item Notes:
D-Link DFE-530TX PCI Fast Ethernet Adapter (Rev B]

Cancel |

3. When prompted to select a network adapter, click Have Disk.

Select Hetwork Adapter

Have Disk.

Metwark Adapter:

Click the Metwork, Adapter that matches your hardware, and then
click OF. If pau have an inztallation dizk for thiz component, click

3Com Etherink 1| &dapter [also 1/16 and K16 TR
ACam Etherink, (11 154/PCMCIA Adapter

3Com EtherLink (Il PCl Bus-Master Adapter [3C530)
ACam Etherink1 /B therLink16 TP Adapter

BEE o Dot el el DL AN ANDACE T A d-rber FICEQET

Hawe Disk.... |

e

[

ok |

Cancel |

4. At the prompt, insert the installation disk provided with your module.

Insert Dizk

Inzert digk with software provided by the zoftware ar
[@ hardware manufacturer. |f the files can be found &t a

different location, for example on another drive lupe a
new path to the files below.

I.ﬁ.:'\.winduws.nﬂ

|

Cancel

For the location, enter A:\windows.nt. Click OK to continue.
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5. Windows will install the drivers.

Setup |
Copying: mxicfg. exe

Tor CRNIRMT Y Suztem32

6. After the files have been installed, a configuration panel will open. Click Add to continue.

&b Moxa PC104 Communication Module Configuration Panel |

Board Type W address | INT wvector | IR | Bus | Dy | COhd Mumber

Al EEMOVE | Property |
o] Cancel |
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Software Installation

7. Under Board Type, select your CA Series model. The window will show the COM port numbers that will
be assigned to the CA Series serial ports, as well as other settings. Click OK to continue.

Property

Board Type |cm 04 Series

i
[+ INT “ector CA132 Series

CA132] Series

Interrupt Mo. |1 0

Baze W0 Port Address 180

=

Port | COM Mo, | Bx FIFO Trig. | Tx FIFO Size

Port Setting

Cancel

8. The CA Series module will appear as a network adapter. Click OK to complete installation of the module.

Metwork |

Identificatinnl Servicesl Protocols  Adapters I Bindingsl

Metwork, Adapters:

Add... Bemove Properties. ..

Update

Item Maotes:

b 0024 PC104 Communication Module Adapter

o |

Cancel
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Uninstalling the Module

1. Right-click Network Neighborhood and select Properties in the context menu.

Explore
Find Computer. ..

K ap Metwark, Drive...
Dizzonnect Metwark Drive...

Create Shartcut
Rename

2. Under the Adapters tab, select your CA Series module and click Remove.

|
Metwork
Identificationl Servicesl Protocols  Adapters | Bindingsl

Metwork dapters:

B8 [1] D-Lirk DFE-530T PC| Fast Ethemet Adapter [Rev B)
(8] C104 Communication Module &dapter

Add.. Remove Properties... Update

Itern Mates:
MOa PC104 Communication Module Adapter

ok I Cancel |

3. A confirmation dialog will appear. Click OK to uninstall the device.

Warning |

Thiz action will permanently remove the component fram the systemn.
[F wow wigh ko reinztall it, pou will have to restart the system before daing 2o

Do wou still wizh to continue?

1o |
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Windows 95, 98, ME

The Windows 95/98/ME drivers conform to the Win32 COMM API standard and support the CA-104, CA-104-
T, CA-132, CA-132-T, CA-132I, CA-132I-T, CA-108, CA-114, and CA-134I.

In the following instructions, the CA-104 is used as an example.
Installing the Driver
1. Insert the CA Series installation disk and run Setup95.exe through Start menu >Run.
Run EHE

Type the name of a program, folder, document, or Internet
rezource, and Windows will open it Far o,

Open; I.ﬁ.:"-.S etupda, ene j

Cancel | Browse. .. |

i Start ||J T &

2. Click Next to proceed through the Welcome screens.

Moxa PC104 Communication Module Drivers Installation E3

Welcome!

This installation program is about to install Moxa
Smartio/Industio driver to your system.

Press the Next button to start the installation. You can
press the Cancel button now if you don't want to proceed
further installation procedure.

Moxa PC104 Communication Module Drivers Installation E3
Ready to Install!

You are now ready to install Moxa PC104 Communication

Madule driver.

Press the Nest button to begin the installation or the Back
button to reenter the Update Driver information.

Cancel

3-10



CA and CB Series Multiport Serial Module Software Installation

3. Windows will install the drivers. When the installation has been completed, click Finish.

Inztalling

Copying Moxa PC104 Communication Module Driver:
C: 4 IM988 S 'S TEM smzizer. wrd

Moxa PC104 Communication Module Drivers Installation

Installation Completed!

The Maxa PC104 Communication Maoduls driver has been
succezsiully installed.

Pressz the Finizh button to complete installation and enter the
Moxa PC104 Communication Module driver configuration
panel,

4. After the files have been installed, a configuration panel will open. Click Add to continue.

‘L Moxa PC104 Communication Module Configuration Panel |

Board Type W address | INT wvector | IR | Bus | Dy | COhd Mumber

Al EEMOVE | Property |
o] Cancel |
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Software Installation

5. Under Board Type, select your CA Series model. The window will show the COM port numbers that will
be assigned to the CA Series serial ports, as well as other settings. Click OK to continue.

Property
EEre T |c104 Series =]
04 :
[+ INT “ector CA132 Series
CA132] Series
Interrugt Mo, |1 0 j
Baze i Port Address 180

Port

COM Mo, | Rx FIFD Trig. | Tx FIFO Size

Port Setting

Cancel

6. The CA Series module will now appear in the configuration panel. Click OK to complete installation of the

module.

't Mozxa PC104 Communication Module Configuration Panel

Board Type

C 04 Series 1580

120 10 -—-

Remove |

12 addressl INT wector @ Bus | Dev | COM Mumber

COMA0 L COMg

Property |

oK |

Cance| |

Open the configuration panel again through Start >Programs ->Moxa Utilities 2 MOXA PC104
Communication Module Configuration Panel.
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Uninstalling the Module

1.

Open the configuration panel through Start>Programs>Moxa Utilities>Moxa PC104

Communication Module Configuration Panel. Select your CA Series module and click Remove

L Moxa PC104 Communication Module Configuration Panel

Board Type

i 04 Series

1C0

180

Remove |

Ciokid0

Property |

. O,

oK |

2. A confirmation dialog will appear. Click Yes to uninstall the device.

Configuration Panel |

@ Do you really want to remove this board 7

Cancel |

3. To remove the driver from the system, open Add/Remove Programs in the Control Panel.

E3 Control Panel M=l E3
J File  Edit “iew Go Favonrtez Help |
S — >
« =& G Y
Eack Eanvwarnd p Cut Copy Faszte
J-"—"-E"I'TESS (=] Control Panel j
Pz B m -
; =
Add Hew BDE Date/Time Diizplay
Hardware Adrminigtrator
ra G
Fants Internet K.evboard kM odernsz |
Controllers Optionz
G- = %‘%
Logitech =
Mouze ultimedia Metwark, ODBC Data Pazswords
Sources [32bit] hd
|'I object[z] selected |_,%‘ by Computer o

3

-13



CA and CB Series Multiport Serial Module Software Installation

4. Under the Install/Uninstall tab, select MOXA PC104 Communication Module Driver and click
Add/Remove.

Add/Remove Programs Properties EE3 |

Install/UIninstall | Windows Setup I Startup Diskl

@ Toinztall a new program from a floppy disk or CO-ROkR
g

drive, click Install
Inztall...

@ The following software can be automatically removed by

Windows, Taremave a program ar ba modify itz installed
components, select it from the lizt and click

Add/Remove.

Microzoft Jet 4.0 Service Pack 4 ;I

| A s, |ntedlio Criver

i 104 Communicaton Module Diver

kDt Srartiod ndustio D river

Mero - Burning Rom [w/eb installer]

Partitiont agic: 5.0

FComm Lite 2.5

PComm ProYer 2.0

Sentingl Svstern Driver ;I
Add/Bemove... |

] | Cancel | ] 1] |

5. A confirmation dialog will appear. Click Yes to remove the driver.

MOXA PC104 Communication Module Dniver

Do you really want ba remove MO PC1 04 Communication Madule Driver

6. After the driver has been removed, click OK to close the window.

M<A PC104 Communication Module Driver E

Femove kMO=4A PCT104 Communization kModule Driver complete |
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Windows CE 5.0

In this section, we explain how to install Moxa CA series boards under WinCE 5.0. These instructions are
intended for users who are familiar with the Windows CE Platform Builder 5.0 ToolKit, and who would like to
install one or more Moxa Tech products. Here, we only give the step-by-step installation instructions for the
development environment. You will need to download the image file to the target host yourself.

The WiIinCE 5.0 driver for the Moxa CA Series PC/104 Multiport Serial Module supports the following

products:

CA Series: CA-108, CA-114, CA-134I, CA-104, CA-132, and CA-132I.

In the the following steps, we are using CA-104 as an example.

Installing the driver

The following procedure explains how to install the CA-104 multiport serial module driver under WinCE.

1. Obtain a copy of the Moxa Tech WiInCE 5.0 driver package and extract it to your computer. Double-click
the Installation icon to copy the Mxpcdrv folder to % WINCEROOT%\PLATFORM\ automatically, and

import the supported Moxa Tech products into the Folder.

2. Start WInCE Platform Builder, and then select File >New Platform.

5 Platform Builder - [Welcome to Platform Builder]

EI|E Edit View Project Platform Target Build Project Build 05 Tools Window Help

LB

= x|
FF) ~
2 2T (n o e
[ Mew Project or File...  Ctrl+Shift+N
(= Open... Ctrl+0 E &
Ci Close
Open Workspace. .. alx
= Catalog
(1 BSPs
(1 Core 03
21 Device Drivers
Home " [ Platform Manager
ame .
(22 Third Party
CHAWINCES
\PEWorksp
CAWINCES
Recent Eles 3 ACP168UME
Recent Workspaces 3
MNew Plz
Manage Catalog Items. ... —
License Run-Time Image....
Exit >
I ~
|
v
» [\, Build / Debug % Log ) Find in Filas 1 Find in Fles 2 f|¢ >
Creates a new Platform Size: “0KB ¥ |=iEm 3
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3. Enter a workspace name and then press Next.

New Platform Wizard - Step 2

YWorkspace Name And Location @
Choose a friendly name for your workspace.

Name:
[Testl] |
Path:

|E:'l,WINCEEI]I]\PBWurkspaces\Tesﬂ'l,

%r)

4. When you see Board Support Packages, Design Template, Applications & Media, Networking &
Communications, OBEX Server, select what you need to build your own environment. The Completing
the New Platform Wizard window will open to indicate that it has created a new platform. Click Finish
to complete the setup.

New Platform Wizard - Step 4

Design Template @

A design template is a pre-defined selection of Catalog items.

Available design templates: Choose the design template that is most
Customn Device 1 closely aligned with the purpose of your

Digital Media Receiver target device.

Enterprise Terminal Provides the starting point for a range of
-| YWeb Pad-based devices with touch display
Gateway and wireless networking.

Industrial Controller
Internet Appliance
IP Phone

Mobile Handheld
Set-Top Box

Tiny Kernel
Windows Thin Client

@ < Back Mext > \ l Finish ] [ Cancel
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Mew Platform Wizard - Step 5

Applications & Media @

Select items for applications and media to include in your 0S5 design.

ltems
o] NET Compact Framgwurk Support for applications and services
[[] ActiveSync designed for the .NET Compact Framework.
~.[] DCOM

] Lightweight Directory Access Protocol [LDi
-[] Standard SDK for Windows CE
--[v] ¥BScript support
o[+ Windows Media AudiofMP3
-] Windows Media Yideo/MPEG-4 Yideo
--[v] Windows Messenger
.[v] WordPad
#-¥ Internet Browser
w-[¥] Microsoft File Viewers
#-[| Windows CE Error Reporting

B | #| Estimated size of these items: 10063 KB

EJ < Back Next > \ [ Finish ] [ Cancel l

New Platform Wizard - Step 6

Metworking & Communications '@
Select items for networking and communications to include in your 05
design.
ltems:
B : | The foundation of the OBEX Application
EIf OBEX Server PP
TCP/IPVG Support Framewuork that provides support for both
& Local Area Network (LAN) standard and user-defined services.

w [ Personal Area Network [PAN]
#-¥] Remote Desktop Connection
#-[¥ Wide Area Network [WAN]

Estimated size of these items: 10924 KB

EI < Back MNext > \ [ Finish ] [ Cancel
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Mew Platform Wizard - Step 7 &]

OBEX Server

Security Warning

Under certain circurnstances, the Object Exchange Protocol (QBEX) catalog itemn can compromise the
security of your platform. This catalog itemn poses the following potential security risks:

® If proper security and authentication techniques are not used, a service that interferes with services exe
can be installed.

w If proper encryption techniques are not used, OBEX running over Bluetooth could expose data packets
to third parties.

To learn more about potential OBEX security risks, as well as the best practices for using this catalog item
more securely, see the following topics:

CBEX Security
Enhancing the Security of a Device

Cancel

@ [ < Back I Next > l

New Platform Wizard - Step B E|
Completing the New Platform Wizard

You have successfully completed the New Platform Wizard.

You have created an 0S design for a Windows CE-based
platform. By default, Platform Builder provides a Debug
configuration and a Release configuration of this 0OS design.

Options:
& Modify build options for the Debug and Relesse configurstions of your O
design withowt closing this wizard.

To close this wizard, click Finisf.

2 Next > | Finish l [ Cancel

5. Select File >Manage Catalog Items In View >Catalog, and browse \Third Party\Device Drivers\
MOXA Smartio/Industio-PC/104. Right-click on the driver Prefix COM or Prefix MXU you would like to
include and choose Add to OS Design.

NOTE You can only select either Prefix COM or Prefix MXU, but not both.
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Prefix COM supports up to 10 ports, from COMO to COM9. Prefix MXU supports more than 10 ports, so it
is better for you to select Prefix MXU if you are not sure how many ports the device has. Otherwise, you
will only be allowed to use one multiport serial board on the target host.

D test2 - Platform Builder - [E:\...\WWxpcdryimxpcdryceb. reg]

File Edit Wiew Project Platform Target Buid Project Build 05 Tools Window Help =2 x|
ECEPC:xBﬁiFIEIease V| B &) [ & # |CE Device v Sm
GRS | v
P IF CAMXU al— e
+- (1 Networking o [HKE\'_LUEHLnMRCHINE\DFlUErS\BulltIn\ = = E Catalo I
=5 SysIntr'=dword:1A ==
+-(_] Parallel “Irq=dword:A =1 B5Ps
+ (21 PC Card “IoBase"=multi_sz:"@180","01c0" =0 Core 05
«-[] PCl Bus “DeviceArraylndex"=dword:8 & (3 Device Drivers
+ ] Printer Devices "Prefix=""Hxu" 5.7 Platform M
+- (27 Serial "D11"="mxpcdru_mxu.Dp11" =3 Third Party
+ (2] Smart Card “index"=duord: 0 =24 Device Drivers
+. (] Storage Devices “lrderiodunrd<8 = i) MOXA Smartiofindustio-PC/104 [Choose 1)
+- (] USB Host "'I"‘lgﬁfylf'“_"“"“;flu @ Mutiport Serial Board [Prefix COM]
5 Sr = "mMX15tF . . . .
=y Enterprise Web Pad[% “IorHandler"="1SRHandler" i RMutiport Serial Board [Prefix MXU
+-(] Applications - End L “ETE0"=dword:1
+ (] Applications and Se “CHIP"=dword:3
+-] Communication Ser
- £4 Core 08 Services [MKEY_LOCAL_HACHINE\Drivers\BuiltIn' e
+] Debugging Tools "Tsp = |.|I'I1I1I:J.I:|EI1I.I:|11 Find
0 Device Manager 29?1531959 =d“°;d:‘_j R !
2 = “FriendlyName"=""Serial Cable on v Docking View
0 Display Suppont “DevConfig =hex: 18,86, 88,88, O ‘
& Internet Applianc Hide:
# (3 Kemel Features [HKEY_LOCAL_MACHINE\Drivers\BuiltInt Help
+- [} Motification LED “sysIntr*'=dword:1A 5! Progert
=[] Parallel Port Sup *Irq"=dword:A roRsrtEs
m Parallel Port [ "loBase"=multi_sz:"@188","681cH"
B PNP Notification: "DeviceArrayIndex”=dword:1
RS 5 ¥ “Prefix"="Hiu"
= # “p11'="mxpcdiu_nxu.D11" e
@ 0s..| @ Pa... J< A SRR 3
#l[ndded the Common Gontrol feature (SYSGEM_COMHCTRL) to the platform. fad

lndded the Real-time Communications (RTC) Client API Feature (SYSGEN_UDIP) to the platform.
Completed the feature and driver list update successfully.

e
Build { Debug % Log % Findin Files 1 Find in Files 2 IE3 >
Adds the selected feature to the platform Size: "22885 KB |3E =HEE 30

6. After adding Moxa Tech drivers into your OS Design, a new project is automatically added to your

workspace. The project name is mxpcdrvce5.reg. The project can be accessed from View ->File View.
The mxpcdrvce5.reg project contains a number of files used to configure the drivers included in your OS
Design. For ISA boards, remember to set the IRQ and I/O address in mxpcdrvce5.reg. For example, if
your IRQ is 10, IOBASE is 0180, Interrupt and Vector is 01c0, then you should configure “1A” for
SysIntr, "0180” and “01c0” for IOBASE, “A” for IRQ ,and “1” for FIFO. When applying the formula
“IRQ+10”, remember that IRQ is in base 10, and 10 is in Hex format. If we first convert the IRQ value to
Hex format, then SysIntr will equal 1A. Otherwise, set FIFO to 1 to enable the FIFO.

NOTE

To use the “Terminal Emulator” tool, modify mxpcdrvce5.reg and keyboard as shown below (this is just for
“one” "COM" port). Take note of the number of ports, COM, and MXU, and then enter the correct
information.

[HKEY_LOCAL_MACHINE\ExtModems\HayesCompat1]

“Port”"="COM2:"

“DeviceType”=dword:1

“FriendlyName”="Hayes Compatible on COM2:”
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D test2 - Platform Builder - [E:\...\Wx

pcdrvimxpodryced. reg]

File Edit Wiew Project Platform  Target

|CEPC: x86_Release
=]

3| =@

x|

=88 EAWINCES00

% Favorites
= Projects

=28 mxpcdrvces

[ Include files
= (1 Parameter files

mxpcdreces.bib
mxpcdreceb.dat
mxpcdreces.db
.E mxpcdrveeb gl
Tojoysge t
postlink.bat
[Z) prelink.bat
[0 Resource files
2 Source files

Build Project  Build ©5 Tools Window Help

v &) [ ) # | |CE Device
M3 R | )| %
IF CAMEU

B

[HKEY¥_LOCAL_MACHINE\Drivers\BuiltIn\CAMXUB]
"SysIntr''=dword:1A
"Irq*=dword:A
“IoBase”=multi sz:"@186","01c@"
"DeviceArrayindex"=dword:8
[T s
xpcdru_mxu.D11"

"Priorit
"IsrD11"

CHIP*=dword:3

L_MACHINE\Drivers\BuiltIn\CAMXUB\Unimodem]
Unimodem.d11™

"DeviceType"=dword: 8

"FriendlyHame"="Serial Cable on MXU B:"
"DevConfig'=hex: 10,08, 66,808, 05,00,00,680, 10,01,00,6

[HKEY_LOCA
Ry T

[HKEY_LOCAL_MACHINE\Drivers\BuiltIn\CAMXU1]
"SysIntr''=dword:1A
"Irq*=dword:A
"loBase"=multi_sz:"@188","681cH"
“DeviceArraylndex"=dword:1
“Prefix”=""HiU"

=

= B Catalog

C1BSPs

(2 Core 05

v (1 Device Drivers

- Platform Manager

=453 Third Party

{4 Device Drivers

=} MOXA SmartiofIndustio-|
a Muliﬁuﬂ Serial Board

@ Mutiport Serial Board

D11’ xpcdry_mxu.D11" =
e Ananaad o T h
> & L
#l[ndded the Common Gontrol feature (SYSGEM_COMHCTRL) to the platform. fad
lndded the Real-time Communications (RTC) Client API Feature (SYSGEN_UDIP) to the platform.
Completed the feature and driver list update successfully.
-

Build { Debug } Log

Press F1 for Help

Find in Files 1

Find in Files 2

>
Size: "22885 KB 2E H0EE 3

After Build and Make Run-Time Image After Build.

4 X86CE - Platform Builder - [C:}._ WPOR Timxucom$MXICOM.cpp]

Finally, open Build OS, select Build and Sysgen, and be sure to click Copy Files to Release Directory

ile Edit View Project Pltform Target Build Project

Build 05 Took Window Help

—l= x|
|CEPC: xB6_Release sa Syseen
8 wLa T3 Byt and Sysgon Gurront BSP R [E] db | CE Device v 5n
v Clean Before Builiing WXUCOM.cpp - Defines i
= BB CAWINCES00 v Capy Files to Relsase Directory After Build = ] Catalog
« (1 PLATFORM Mk Run-Time Image After Build T I (1 BSPs
# 1 PRIVATE nclude “HAUCOM. b -1 Core 03
=1 public SovBe b Releas Dinckny nclude “com.h* [ Device Drivers
¢ Favorites S A i nclude “Hoxa.h™ %1 Platform Manager
= i Projects =3 Third Party
5 @ mxpedrvces OHG  DbglLevel =DBE_D = 53 Device Drivers
(3 Include files Bach Buid... ) = &) MOXA Smartiofindustio-PC{104 [Choose 1)
= (1 Parameter files B Open Release Dieetory exine:hal i {3 [Mutiport Serial Board [Prefix COM)
B il Mutiport Serial Board [Prefix MXU
) mxpedryceS.bib iAot Cont umton £ HRU o P ( )
[2) mxpedrvceS.dat e efine COM_Glose
[E] mxpecdrvees.db = efine COM_Open
[2) mxpcdrveeb.reg #define COM_Deinit
ProjSysgen.bat #idefine COM_Init
postlink.bat nueF?ne COM_IoControl
S) prelinkbat Hdefine COH_Read
- Hidefine COM_Write
3 Resource files Hendif =
(3 Source files
BOOL
DL1Entry(
HINSTANCE
DWORD  u
LPUOID 1
)
{
DOUT(DBG INIT,(TEXT ¥
B 0SDesignView | ParameterView |* ClassView | ] FileView | It ¢ el
=[added the Real-time Communications (RTC) Client API feature (SYSGEN_UDIF) to the platform. -~
Completed the feature and driver list update successfully.
=
Build ¢ Debug 5 Log 3 FindinFiles | IE3 *

8. Finally, copy your image file to the target host.

NOTE

If you created a Windows CE Platform Builder in the development environment, skip steps 2, 3, and 4.
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Older OS for CB Series

DOS

Moxa DOS API-232 is a software package that can help you develop or debug serial communications
programs. This section will explain how to install the package, set up the driver, and load or unload the
driver. For additional information about the API-232 library and utilities, please refer to Chapter 4.

The DOS drivers support all models in the CB Series.

In the following instructions, the CB-104 is used as an example.

Installing the Driver

Run the installation program, DOSINST.EXE, in the DOS folder. Specify the target directory for the API-232
files (e.g., C:\MOXA). Press F2 to start the installation.

N B AN

It o TN

After the installation has been completed, you will be prompted to set up the board and driver initial values.
We strongly recommend that you do so.
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Driver Setup

The following instructions are not intended to illustrate every function of the setup program. For more
detailed information, please refer to the help files by pressing F1 in the setup program.

1. Run the setup program BIN\SETUP.EXE.
2. Select your CB Series model and press Enter.

3. A window will open, displaying all configuration information for all installed modules. Press PgDn to view
advanced port setup options and to make configuration changes. Your module’s configuration will be
displayed along with other settings such as port number, buffer size, etc.

4. Verify the settings and make any necessary changes.

Porl =l

et At FAHG - £ fikort

Port number: This is the port ID of each port. Application software will refer to a port by its port
number (ID). Port numbers must be unique; duplicate port numbers are not
allowed. The port ID can range from 0 to 127 as long as it does not overlap with
another port. Generally, you should consider the convenience of programming
when specifying the port number.

TxD buffer size: This is the transmission (output) buffer allocated in the system for each port.
RxD buffer size: This is the receiving (input) buffer allocated in the system for each port.
F5: Group Edit: This allows you to configure several ports simultaneously as a group.
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e wlt L]

Eigiaige

S Rhart

5. Press F10 to save the latest configuration and exit the setup program.

Loading the Driver

After setting up the driver, you must load the driver in order to gain access to the serial ports on the
module. Run BIN\DPC-DRV.EXE at the DOS prompt. The driver will detect your CB Series module
automatically. You should see messages indicating successful detection of your module, such as the
following:

Smartio/Industio Family DOS driver Version 1.8
Setup driver ...

CB-114 series (Bus=x, Dev=y): OK!

Device driver setup O.K.

At this point, you can execute applications that support API-232 functions, or start developing applications
using the API-232 library.

Unloading the Driver

To unload or release the CB Series driver from memory, enter DPC-DRV/Q at the DOS prompt.
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Windows NT

Installing the Driver

You will need to plug the board in an available PCI or PCI-X slot first, before installing the driver.

Note that these instructions use the CB-114 as an example. The procedure for installing all models is the

same.

1. Log into Windows NT as Administrator.

2. Locate the appropriate folder for your board’s drivers on the Document & Software CD. The NT drivers
will be located under the product folder in the \Software\WinNT directory (e.g., under \CB-114
Series\Software). Copy this folder to the PC’s hard disk and remember its location.

3. In the Control Panel, open Network applet. On the Adapters tab, click Add. When prompted to select
a product, click Have Disk....

You will be prompted to enter the path to the driver. Enter the location of the drivers that you copied
from the Document & Software CD (C:\Windows.nt in this example) and then click OK.

|derification | Sewsices | Froiocoks Adacks | Birdins |
P=tvacrk A phe =

“ I-I T ke BT PP 24 T AT B i cem e ™ maes i
18 Select Metwork Adapter K E3

Cick ihe Hetwork adepier that matches your hadwaie, snd then
ZZFET | licds CE 1iiris bewie aniratallation disk e thie cormmorent chels

Irert Dk

Irzestt dizk with softeaane provided by the: sof v or

ﬁ hadware manufzchuier |F ihe liles ca4 be lound 2l 2
ditfereri laation. for ekampl: o shother drive poe 2
o parhiba the floe below, _Caredl |

II:.;M'\.V]nd;.ws_n‘

4. When prompted, select your board model (Smartio/Industio Family multiport board in this
example) and click OK.

Select DEM Option

Choosz a software suppoted by ths hardware marulacturers disk.

e i Famio maiad bamd

0K I Canczl Help
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5. After the files have been installed, a configuration panel will open. This is where boards are installed,
configured, and removed. If another board has already been installed on the system, it will already be
listed. Windows NT does not automatically detect Moxa UPCI boards, so you will need to click Add for a
newly installed board.

sy Moxn Smartiod| ndustio Configuation Pamel

Bioard Type 100 s | T vector | o | Bus e | OO rlumber

ik | Propary |
2K anca|

6. Under Board Type, select the UPCI board that is being installed. The window will show the COM settings
for the serial ports on the board. You can modify the COM settings for any port at this time by selecting
a port and clicking Port Setting. If you are satisfied with the COM settings, click OK to return to the
configuration panel.

Property
Board Type OKE CB-114 Series
[ T vestor
Interrupt No. 4E v
Ease 'O Port Address AL

Port | COM Mo, | Rx FIFQ Level  Tx FFO Level

1 COM3

2 COM4  High High

3 COMS  High High

4 COME Hichi High
Eartlnta Poart Setling
oK Cancel
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7. The board will now appear in the configuration panel (CB-114 Series in this example). Click OK to
return to the Network applet. After that, click OK again to exit the Network applet

ik Moxa Smartio/Industio Conhguration Panel

VO address | INT vector | IRQ@ Bus  Dev  COM Number |

ACOC 48 2 12 - COMB

Board Type

MCCA T H=-114 Senes A500

COE

Remove I Property |
Ok ' Cance] |

8. Restart the PC. After you have logged back into Windows NT, you may check the event log issued by the
Moxa driver to see if the board’s ports have been initialized successfully. In the Administrative group,
open Event Viewer and select Log and System. For each newly installed or configured Moxa UPCI
board, check for a message stating that the board has been enabled (e.g., "MoxaCB-114 board, with
first serial port COM3, has been enabled”).

Configuring the Ports

1. In Windows Control Panel, open the Network applet. In the Adapters tab, UPCI boards will appear as
a type of Moxa adapter (MOXA Smartio/Industio Family Adapter in this example). Select the Moxa
adapter and click Properties....

Network  _ HBEH|
Id:nliltalim] Sl:wl:l:sl Protocok  Adantan: ] Eirdrus]

Helwark Adaplers:
@2 [1] IntelF ) PROA00YE Neboork Commection

[2] M4 5 mached noushe Family Adanker

Add... Bemaovs | _F'n:q:laltiu...l Updzt= I

tem Holes
0= Smaitio/Indugto Family Adaplen

ak Cancel
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2. The configuration panel will open with a list of installed boards. Select your board and click Property.

Up to four Moxa UPCI boards can be installed at a time.

ik Moxa Smartio/Industio Configuration Fanel

Board Type

MUCED T H-11 & Seres AS00

12

Remowve I
_ x|

VO address | INT vector | IRQ | Bus Dev  COM Number |

COM3 - COMB

Property |
Cance] |

3. Select a port to configure and click Port Setting.

Property
Board Type MOXA CB-114 Series
I N7 vectar
Interrupt No. [ ="
Basze /O Port Address AL

x|

Port COM¥o. | RxFIFOLevel TxFFO Level

1 COM3

2 COM4  High g

3 COMS  High el

4 COMB  High High
EIFE ([{[E Eﬂﬁ SE¢HHB
= Cancel
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Under Port Number, select a COM number to assign to the serial port. Select Auto Enumerating COM
Number to map subsequent ports in nhumerical order. For example, if COM 3 is assigned to Port 1, then
COM 4 will be automatically assigned to Port 2.

s ]

¥ Auto Enumes sting COM Mumier

Fo FF Level High

[¥ St te changs to &l poets

Tr FFO Lewsl Hich

[ = tre chang= to |l port

O I Cance| |

4. Select an Rx FIFO Trigger and Tx FIFO Size. The default Rx FIFO Trigger is 120 bytes (high level).
The default Tx FIFO Size is 128 bytes (high level). Select Set the change to all ports to use this
setting for all serial ports on the board.

TxFIFO RxFIFO
High 128 120
Middle 64 60
Low 1 1

5. Click OK to approve the settings for the selected port. Continue in the same way to configure the other
ports. When you have finished setting up the ports, click OK to close the Properties window and apply
the new port settings. Click OK again to exit the Network applet.

ok Moxa SmartiofIndustio Configuration Fanel

Board Type VO address | INT vector | IRQ | Bus  Dev | COMNumber |

MOEA T H=119 Seres 4300 AC0C 48 2 3 - COMB

Remove: I Property
O I cance] |

Removing the Board

To remove a board, shut of your PC and physically remove the board from the PCI slot. The next time you

start up the PC, Windows NT will automatically remove the configuration. You do not need to go through the
Windows control panel.
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Updating the Driver

1. In Windows Control Panel, open the Network applet. Under the Adapters tab, UPCI boards will
appear as a type of Moxa adapter (MOXA Smartio/Industio Family Adapter in this example). Select

the Moxa adapter and click Remove.

1|
Ickniilization | Sereies| Frotocols Adagtsr | Bindings |

Helwark Adaphers:
@3 1] Ini=lF ) FRO.ADOYE Nehwork Commeclion

[2] M 038, Smertind nouzhio Family Bdeptes

Add.. (‘I Bemows imalﬁa;...l Updst=

J=m Koles —

O, SmaitioIndosto Famly ddaplel

n] 4 Cancel

2. Restart the system.
3. Go through the process of installing the drivers, using the new drivers.

Removing the Driver

1. In the Windows Control Panel, open the Network applet. Under the Adapters tab, UPCI boards will
appear as a type of Moxa adapter (MOXA Smartio/Industio Family Adapter in this example). Select

the Moxa adapter and click Remove.

S =]
Ickniiicalion | Sewvies| Frotocols Adantee | findings |

Hefwark Adapters:
PROA00VE Hewuerk C

ddt. (" Fenove [[Topeiier. | Upds= |
‘-‘-'-—-/

Jem Holes
05Ch Sinaito/Ind.sta Fanly Acsplen

0ok Carcel

2. Click OK to exit the Network applet and restart the system.
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Windows 95/98/ME

Installing the Driver

Windows 95
1. After the board is physically installed and the PC boots up, Windows will automatically detect the new
board and the Found New Hardware Wizard window will open. Click Next to continue.

Update Dey

Thiz wizad wil comnpleie the ingalation of

PO Senel Contalie:

by e=aiching paur oz al dives, netacr, zhd Inteinst
lezkions for the most curnent: diiver.

IF wou hiawe @ disk o CO-ROM thar come wath bz davics,
naerkib nowd.

b 1= recammended that pou et Winoaws seanch far an
wodmeed diver Ta do the dick Hest o cononus,

Cancal

2. Select Other Locations...

te Device Diive

whirdoss was unsble to bosle s diver for this devie=

faud da mal war ba irstEl & dives fow, dick Fingh, To
szalchfor a diver manalp, chek Dikher Locaiors. Oi, o
Jegn the automatic search again, dick Back.

Cancel I

3. Click Browse and select the appropriate directory on the Document & Software CD for the driver.
Drivers for all operating systems are located under the product folder in the \Software directory. Select
the \Win9x folder and click OK to continue.

Tpoe the name ol the folde that contains the drvcer youwart Ta zeaich hor a ldd=r, chck
Hrowse

Liozehion

LAF

ok Cancal
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4. After Windows finds the drivers, click Finish.

Add Hew Hardware Wizard

‘Windows driver file search for the device:

MOxA CB-114 Senes (PC/104-Flus)

IF pou want to use this diver, click Fiuizh. If this iz not the
corect diver and you want to search for a different driver
manually, click Other Locations.

Location of Driver

;, Windows. 95

Other Locations. .

< Back

You can configure and use the new COM ports right away without restarting Windows.

Windows 98 and ME

1.

After the board is physically installed and the PC boots up, Windows will automatically detect the new
board and the Found New Hardware Wizard window will open. Click Next to continue.

Audd Hew Hardwere Wizard

Thiz wazerd s=aches For nee dirvers For:

FCI Serial Contrallen

A device diiveriz o safwae progrom thet nakes o
hardware dewics work.
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Select Display a list... and click Next.

Add New Hardware Wizand

‘Wizt da you went Windaws o do?

" Smach lor e bazi diver for pon device.
[Recommerded|.

% Display mlis of al he diversin a speofic :
ocalian, zoyou cen seect lhe dinver oo wanki

< Back Mt Canzel |

Select Other Devices and click Next.

St the lype ol devics from the e belaw, then click
Hesk

Mauze ;l
WukHunclion adaphss

MuklDCarkialkr

Webaok adapian:

[ih=r detecter dewvie=z

PO, sacked

Portz [COM & LPT]

e

ECSI cortrolien: =
4 Badk Mest > Cancal I

Select Have Disk...

Add Hew Hardware 'wizand

Sebect the marulachuer avd madalof your hardwans davica. | vauhave 3
dizk thal conbains the updated diver, cick Have Disk Ta kskal ke updated
driver, cick Firich.

Hawa Dk .. I

< Back Mect > Cancal |
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5. Click Browse and select the appropriate directory on the Document & Software CD for the driver.

Drivers for all operating systems are located under the product folder in the \Software directory. Select
the \Win9x folder and click OK to continue.

Irs=r! the mamd actuis's instalalion dsk into
——r thez diivi selected, and then cick OF.

Cancal I

Coarp manutactuer's Hles o

|E j Browee. .. I

6. After Windows has installed the drivers, click Finish.

Add Hew Hardware Wizard

_\‘) P00 CE-1 14 Series [FCS104-Flusz)

Windows has finished installing the software pou selected
that pour new hardware device requires.

Configuring the Ports

Configure the COM ports after the board and drivers have been installed.
1. In the Windows Control Panel, open the System applet.

B85 Conbiod Panel
| Fle Edi Mew Bo Fawoiles Hel -
| - =+ L 5 . % =
finr Feriard U Map Diive Discowesst Cut
| Adebesa [ Canral Fanei =l
B = e
% B ® e
ibddtem!  Addfenoee D Time Diiplay Fones Gam=
Hardwae Programs Corbmlbere

@ = 3 D B %

Irdanet Feoraid Fcues Fili ez [RET

Dptiors
. . 4 A
W‘% i i
g 2 »2 @ =2
ODEC Dz Paesmorce Proveszr Frikess Regiona Bounds
Soukce: [Z0hi| g enent Settrge
LE

EMmepuul o
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2. In the Device Manager tab, expand the Moxa Smartio/Industio multiport board category by

clicking the “+" sign next to it. Select the desired board and click Properties.

System Projc

" \liew devices by lype

Gel

ardwae Profiles | Pelfurmanr:e|

™ View devices by connecton

@ Computer
-2 CDROM
=9 Disk drives

£

# @ Dizplay adapters
-5 Floppy disk contrallers
i+ 52 Hard disk controllers
&8 Keyboard

o

Q Maonitors

3

pdMO%A CB-114 Series

- Ports (COM & LPT)
* g System devices

Properties | Refresh I

= v Moxa Smarhio/lndustio mubiport board

Remove |

Print. .

o]

Carnicel I

3. Under the Ports Configuration tab, select a port to configure and click Port Setting.

Property

=]

Board Type

I N e stor

Irderrupt Mo.

Base 110 Part Address I AZ00

Port  COM o, | Rx FIFO Level | Tx FIFO Leyel

el ‘ Port Saﬂingl

Cancel |

3-34



CA and CB Series Multiport Serial Module Software Installation

Under Port Number, select a COM number to assign to the serial port. Select Auto Enumerating COM
Number to map subsequent ports in nhumerical order. For example, if COM 3 is assigned to Port 1, then
COM 4 will be automatically assigned to Port 2.

I¥ Avto Enumessbing SO Wumber

For Munbar

Bt FFO Level High -

[V Setthe changs to sl poets

Tz FFO Lewsl High =

¥ 2t the cheng=s to Al ports

[ o ]

Carce| |

4. Select an Rx FIFO Trigger and Tx FIFO Size. The default Rx FIFO Trigger is 120 bytes (high level).
The default Tx FIFO Size is 128 bytes (high level). Select Set the change to all ports to use this
setting for all serial ports on the board.

TxFIFO RxFIFO
High 128 120
Middle 64 60
Low 1 1

5. Click OK to approve the settings for the selected port. Continue in the same way to configure the other
ports. When you have finished setting up the ports, click OK to close the Properties window and apply
the new port settings. Click OK again to close the Device Manager and restart the system.

Updating the Driver

You may configure the COM ports after the board and drivers have been installed.
1. In the Windows Control Panel, open the System applet.

B3 Controd Panel
. Bl Edt Miew Goo Fzeoiber Hep
L e I S - | -
| EEoy RIETC Up Map Driva D sorFssl Cul
-!u_idl:urzl Corired Perel j
.ﬁ' if2 I a
< %—" Lg 4 A,
ifdd Mew!  AddPemeve  DateTime Display Fonis Game
{Haidwale,  Piograms Convoikess
e ks : -
&G =2 @ D B =25
Inteinet ey Modens Mouze Mukimeds et
Oplicre
5 13 2 ' g
g N1 = @9 L
ODHC DAt Pacsaoids Fowe Firdeiz Hegiora Sourds
W Enagsme Setings
(J
=1y Conpuden %
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2. Under the Device Manager tab, expand the Moxa Smartio/Industio multiport board category by
clicking the “+" sign next to it. Select the desired board and click Properties.

System Propciues

&) COROM

(& Disk driives

- Display adapters
-5 Floppy disk controllers
m% Hard disk contrallers
& &3 Keyboard

+- W Monitors

Mowxa Smartio/lndustio Mmﬂ@

Elj Ports [COM & LPT]
EI*-‘ System devices

3. In the Driver tab, click Update Driver....

MOXA CB 114 Series (PC/ 04 -Plus) Properties
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4. Select the appropriate model (CP-168U in this example) and click Have Disk...

Update Device Driver Wizard I

Select the manufacturer and nodel of your hardware device. If you have a
disk that contains the updated driver, click Have Disk. To install the updated
driver, chick Finish.

Models:
CP-1041 Sefies -
CP-114 Sernies _i
CM-132 Seres

CP-132U Senes
CP-134U Series _]
CB-114 Series :’

rT-114 Senes

Have Disk... |

< Back Newt> | Cancel |

5. When prompted, select the appropriate directory on the Document & Software CD for the driver. Drivers
for all operating systems are located under the product folder in the \Software directory. Select the
\Win9x folder and click OK to continue.

6. You will be prompted to restart the system. The new drivers will be in effect the next time you restart.

Removing the Driver

1. In the Windows Control Panel, open the Add/Remove Programs applet. On the Install/Uninstall tab,
select MOXA Smartio/Industio Driver and click Add/Remove.

Add/Aemove Programs Properies

IngsallUring:all | wintows 5 etup | Staur Disk |

% Tairebal & e progran fam a Bopey disk o CO-ROM

dirve, dick Instal.
Iretell

The idlaveg aalbesae con be avkomateolly mroved by

f] ‘windows. To iemawe 2 program or bo moditp b= nsteled
componenls, select it rom the likt 2nd click
AddRemove

|55 315315

AodeH e I

ok | Carcel I Bl I
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2. When prompted, click Yes to confirm that you want to remove the driver.

MO=A Smantio/lndustio Driver

Famowe MO 5 marliod Induwstio Direer comolehs |

Windows CE 5.0

In this section, we explain how to install Moxa CB series boards under WinCE 5.0. These instructions are
intended for users who are familiar with the Windows CE Platform Builder 5.0 Toolkit, and would like to
install one or more Moxa Tech products. Here, we only give the step-by-step installation instructions for the
development environment. You will need to download the image file to the target host yourself.

The WInCE 5.0 driver for the Moxa CB Series PC/104-Plus Multiport Serial Module supports the following
products:

CB Series: CB-108, CB-114, CB-134I

The CB-114 board is used to illustrate the installation procedure.

Installing the driver

The following procedure explains how to install the CB-114 multiport serial module driver under WinCE.

1. Obtain a copy of Moxa Tech WiInCE 5.0 driver package and extract it to your computer. Double-click the
Install package to copy the Mxser folder to %WINCEROOT%\PLATFORM\ automatically, and import the
supported MOXA Tech products into the Folder.
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2. Start WIinCE Platform Builder, select File, and open New Platform.

© Platform Builder - [Welcome to Platform Builder]

JH File Edit View Project Platform Target Build Project Buld OS5 Tools Window Help

H-_E o] New Platform... Cirl+N - ”E,E,E %.a | Eit| v|| TH‘
f— D Mew Project or File...  Ctrl+5hift+ o
H_E.“‘gpen... Ctrl40 : |Dl\ﬂ_".'lm°° 5| @@|
“E Close
= Open Workspace. .. ~ P
: =] ﬂ Catalog
-1 BSPs
. w1 Core 08
o [ Device Drivers
‘Name @30 Platform Manager
N -3 Third Party
CHVWINCES
\PEBWorksp
B Stk Ci\WINCES
Recent Eiles ACP168UVE
Recent Workspaces
MNew Plz
Manage Catalog Items.... N
License Run-Time Image....
— v
_ Ext k)
| ~
K
v
Build ;{ Debug % Lo Find in Files 1 % Find in Fles 2 A< /] >

Creates a new Platform

3. Enter a name for Workspace and press Next.

Size:

New Platform Wizard - Step 2

Workspace Name And Location
Choose a friendly name for your workspace.

Name:

Path:
-]

| EAWINCESDWPBWorkspaces\Testl)

Finish

< Back

Cancel
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4. When you see Board Support Packages, Desigh Template, Applications & Media, Networking &
Communications, OBEX Server, select what you need to build your own environment. The
Completing the New Platform Wizard window will open to indicate that it has finished creating a new
platform. Click Finish to complete the setup.

New Platform Wizard - Step 4

Design Template \b)

A design template is a pre-defined selection of Catalog items.

Available design templates: Choose the design template that is most
1 closely aligned with the purpose of your
target device.

| Custom Device

iDigitaI Media Receiver
|

|Enterprise Terminal Provides the starting point for a range of
E! Web Pad-based devices with touch display
| Gateway and wireless networking.

!Industrial Controller
|Internet Appliance
IP Phone

| Mobile Handheld
iSet—Tup Box

| Tiny Kernel
|Windows Thin Client

@ < Back Next > ‘ l Finish ] [ Cancel ]

New Platform Wizard - Step b

Applications & Media @

Select items for applications and media to include in your 05 design.

ltems:
[v] MNET Compact e | Supponrt for applications and services
Al ActiveSync designed for the .NET Compact Framework.
~[] DCOM

-] Lightweight Directory Access Protocal [LDi
[] Standard SDK for Windows CE

..[v] YBScript support

-[v] Windows Media Audio/MP3

-[¥] Windows Media Yideo/MPEG-4 Yideo
[v] Windows Messenger

-[v] WordPad

#-¥| Internet Browser

#-[¥] Microsoft File Viewers

#-[_| Windows CE Error Reporting

£ | _>_! Estimated size of these items: 10063 KB

@ < Back Next » \ [ Finish ] [ Cancel
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New Platform Wizard - Step 6

Metworking & Communications '@
Select items for networking and communications to include in your 05
design.
ltems:
[ [v] BEX Server | The foundation of the OBEX Application
: TCPAIPvE Support Framework that provides support for both

& Local Area Network (LAN) standard and user-defined services.

w [ Personal Area Network [PAN]
#-¥] Remote Desktop Connection
@ Yide Area Network [WAN]

Estimated size of these items: 10924 KB

EI l < Back [ Next > \ [ Finish ] [ Cancel l

X

Mew Platform Wizard - Step 7

OBEX Server

Security Warning

Under certain circurnstances, the Object Exchange Protocol (QBEX) catalog itemn can compromise the
security of your platform. This catalog itemn poses the following potential security risks:

® If proper security and authentication techniques are not used, a service that interferes with services exe
can be installed.

w If proper encryption techniques are not used, OBEX running over Bluetooth could expose data packets
to third parties.

To learn more about potential OBEX security risks, as well as the best practices for using this catalog item
more securely, see the following topics:

CBEX Security
Enhancing the Security of a Device

)
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New Platform Wizard - Step B

Completing the New Platform Wizard

You have successfully completed the New Platform Wizard.

You have created an 0S design for a Windows CE-based
platform. By default, Platform Builder provides a Debug
configuration and a Release configuration of this 0OS design.

Options:
& Modify build options for the Debug and Relesse configurstions of your O
design withowt closing this wizard.

To close this wizard, click Finisf.

(@ Mext > | Finish l [ Cancel

5. Open Manage Catalog Items (File >Manage Catalog Items). Under Catalog (View >Catalog),
browse t\Third Party\Device Drivers\ MOXA Smartio/Industio-PCI, PC/104-Plus. Right-click on
the driver Prefix COM or Prefix MXU you would like to include and choose Add to OS Design.

NOTE You can only select either Prefix COM or Prefix MXU, but not both.

Prefix COM supports up to 10 ports, from COMO to COM9. Prefix MXU supports more than 10 ports, so it
is better to select Prefix MXU if you are not sure how many ports the device has. Otherwise, you will only
be allowed to use one multiport serial board on the target host.
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D test - Platform Builder - [Welcome to Platform Builder]

E\Ie Edit View Project Platform Target Build Project Buld QS Tools MWindow Help

|CEPC: xB6_Release || b4 [ o [ 2 #| |CE Device v % 2
3 Ld | Bl
| A |
=88 test Catalog items » ] Catalog |
+- ¥ CEPC: x86 T BSPs
-] Device Drivers [ Core 08
=-dh Enterprise Web Pad[Windows [ Device Drivers
+ (] Applications - End User s &3 EI Platform Manager
+-[[] Applications and Services | (=-3 Third Party
+ [[] Communication Services a EAWINCES =23 Device Drivers
= £3 Core 0S Services EAWINCESC = B} MOXA SmartiofIndustio-PCl,PCH04-Plus [Choose
+ -] Debugging Tools 0
[ Device Manager Mew Plat @ Mutiport Serial Board [Prefi
0 Display Support e
& Internct Appliance [lABA
+ -] Kernel Features Refrash Catalog
+ [} Notification LED Suppor =
=[] Parallel Port Support =
“3{Paraite Pon Driver] Fy— Do o
[ PNP Notifications e Hide
- [ Power Management [Ful
@ Serial Port Support Notil . bl !
[ Ul based Notification wind Properties
+ [ USB Host Support Devit
+-[] File Systems and Data Sto Mind
+-(] Fonts Yearl
+ (] Graphics and Multimedia T thra
+-] International @ Micre
< == = ] 3 Wind
- »
B 05Desi... J@ Paramet...J EIFiIeViewl < S < >
*l/added the Real-time Communications (RTC) Client API feature (SYSGEN_UDIP) to the platform. ~
Completed the feature and driver list update successfully.

Build { Debug % Log % Findin Files 1 Find in Files 2

Adds the selected feature to the platform

b
>

Size: 72865 KB [*E |EE 5@

After adding Moxa Tech drivers into your OS Design, a new project is automatically added to your

workspace. The project name is mxserce5. The project can be accessed from File View (View >File
View). The mxserce5 project contains a number of files used to configure the drivers included in your

OS Design.
D test - Platform Builder - AMxser\mxserce5.reg]
Eile Edit Wiew Project Platform  Target Buid Project Build 05 Tools Window Help ;@ﬂ
ECEPC:XBB_REIease v | B [l A [#] | |CE Device v| %m
I LD DEDE W v %
| IF PCIMXU = NE|

=88 EAWINCES00

er_nxu.D11"
¢ Favorites m
=43l Projecls “UendorID"=nulti_sz:"'1393"
= evice =mu. 1 SzZ: »
mxserce5 "DeviceID"=multi_sz:'"'1822'
[ Include files “Class'=dword: 87
-1 Parameter files "*SubClass”=dword: 88
mxserce5.hib “index"=duord:0
[E] mxserceb.dat ulsrbll i Er.dll .
IsrHandler ISRHandler

[5) mxserce5.db

mxserceb.reg

ProjSysgen.bat

“Tep”="Unimodem.d11"
"DevicefArraylndex"=dword:8
"Order'=dword: @
"DeviceType”=dword: 8
"FriendlyName™="MOXA Serial Port "
“FIF0"=dword:1

“CHIP"= dword:1

E

[E) prelink.bat
1 Resource files
(1 Source files

"Tsp"="Unimoden.d11"
“DeviceType''=duord: @

[HKEY_LOCAL_MACHINE\Drivers\BuiltIn\HXU1]
“order”=duord:100

“Tsp”="Unimodem.d11"

[HKEY_LOCAL_WACHINE\Drivers\BuiltIn\PCI\Tenplate\HOKA =

"1303","1393","1393" "1
10217 ,"1321"," 1020, "1

[HEEY_LOCAL_MACHINE\Drivers\BuiltIn\PCI\Template\HOXA

“DeuConfig”=hex: 16,680, 60,08, 05,00,00,00, 16,61
"FriendlyName"="Serial Cable on HXU @:"

[HEEY_LOCAL_MACHINEADrivers\BuiltIn\HXU1\Unimoden]

53 Device Drivers
= B MOXA Smartiofindustio-PCLF
@ Mutiport Serial Board [Pre

--[ [Mutiport Serial Board (Pre

" T oo i )
J DeviceTune'=dunrd: A 5 ¢ 5
#[added the Real-time |[Commu[Fisview]lons (RTC) Client API feature (SYSGEH_UDIP) to the platform. ~
I Conpleted the feature and driver list update successfully.
Vv.

Build { Debug ) Log } FindinFles 1 ) Find in Files 2 I3

Press F1 for Help

>
Size: "22885 KB ¥ 4HE® 3
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If you would like to use the “Terminal Emulator” tool, please modify mxserce5.reg and keyboard like below

NOTE
(This is only just for “one” "COM” port). You have to take note of the nhumber of ports, COM, MXU, and enter
the correct information.
[HKEY_LOCAL_MACHINE\ExtModems\HayesCompat1]
“Port"="COM2:"
“DeviceType”=dword:1
“FriendlyName”="Hayes Compatible on COM2:"”
7. Finally, open Build OS, select Build and Sysgen, and be sure to click Copy Files to Release
Directory After Build and Make Run-Time Image After Build.
© a_test - Platform Builder - [Welcome to Platform Builder]
Eile Edit View Project Platform Target Build Project |Build OS5 Tools Window Help - = ﬂ
EIRl= =i} o= 53 Sysgen v ?ﬂ
CEPC: x86_Release Build and Sysgen Current BSP @ @
CE Device 3 JE’EI Clean Before Building
= = |/ (Copy Files to Release Directory After Build =
v Make Run-Time Image After Build
7] ActiveSync Catalog
File Sync Copy Files to Release Directory (1 BSPs
i CAB File Instal Make Run-Time Image (1 Core 08
+--[_] File Viewers 1 Device Drivers
[ Help Home [0 Platform Manager
+-_] Remote Desktc Batch Build... [ Third Party
EI WordPad B Open Release Directory
+-[_] Applications and !
+ [:l Communication S Set Active Configuration. ..
+ -] Core 05 Services Configurations...
+-[_] File Systems and
+ -1 Fonts New Plz
4177 Rranhire and kiul ¥ —
4 d
- b
Bo.. j@p. [*ic..|=Fr.] [« 5
#||added the Common Control feature (SYSGEM_COMHCTRL) to the platform. ~
Completed the feature and driver list update successfully.
w
» [ Build / Debug % Log % Find in Files 1 Find in Files 2 /1 < >
Builds files in the tree for this 05 design and then runs the Sysgen tool, and builds proje Size: 17412 KB dm =65
8. Finally, copy your image file to the target host.
NOTE If you have created a Windows CE Platform Builder in the development environment, skip steps 2, 3, and 4..
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Newer OS for Both CA/CB Series

The content below will describe the software installation for newer Windows OS, including Windows
2000/XP/2003/Vista/2008/7/8/8.1/10 (x86/x64), Windows Server 2008 R2/2012/2012 R2/2016 (x64)

The following topics include

a Installing the Driver
Configuring the Ports
Checking the Status
Removing the Driver

[ R R

Uninstallation the Driver

We will take Window 7 (x64) for example, to let you know how to install your CA or CB boards. The
installation procedure of Windows7 is similar to the other Windows platforms. The content describes how to
install, configure, check the port status, remove, or uninstall the CA or CB boards.

NOTE

In the installation section, the CA Series has more installation procedures as it follows the ISA standard. The
content will be added, followed by the installation part of CB Series.

Installing the Driver

In this section, we will describe how to install the CA or CB boards for the first time with Windows 7.

First, make sure that you have already plugged the board or boards into the system’s PC/104 or PC/104-
Plus slot(s).

NOTE

If you have already installed Moxa CA or CB board(s) in your computer, and you are installing additional
boards, Windows 7 will automatically detect and install the new board(s) the next time you boot up the
computer. In this case, proceed directly to the next section, “Configuring the Ports,” to configure the ports’
serial transmission parameters.
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Second, download the drivers at www.moxa.com. Based on the OS type, choose the corresponding driver.
Then, follow the following procedures to install the driver.

1. The Setup Wizard will open. Click Next to install the driver.

BJ Setup - MO SmarioIndustio Windows Driver EI =] @

Welcome to the MOXA
Smartio/Industio Windows Driver
Setup Wizard

Q

Thiz wall ingtall MO Smartiod ndustio Windows Driver Werl . 24
ar your comprter.

[t iz recommended that you close all other applications befare
continLing.

Click. Mest to continue, or Cancel to exit Setup.

M et > ]| Cancel

2. Please read the license agreement. If you agree, click Next to move on.

15! Setup - MOXA Smartio/ndustio Windows Driver E = @

License Agreement
Please read the fallowing impartant infarmation befare cantinuing.

Pleaze read the following License Agreement. You must accept the terme of this
agreement before continuing with the installation

MOXA END-USER LICENSE AGREEMENT -
FOR MOXA SMARTIOINDUSTIO WIND OWS DRIVER

IMFP ORTANT: Please Read This Agreement Before Using The Software
Indicaied Above.

This End-User License Agreereent (“EULA") is a legal agreerment between sou,
the Chustomer {either as an individual or a single entity), and the Cramer
concerning this special parpose (“Systera™) coraputer device that ineludes certain _
. - b TR

e meballnd Al Crendews Tanballiae

@ E

| do nat accept the agreement

< Back |[ Mexst > ]l Cancel
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3. Click Next to install the driver in the indicated folder, or use the drop-down folder list to locate a
different folder.

EJ Setup - MCRA Smartiofdndustio Windows Driver E' (=]

Select Destination Location
Where should MO=2A Smartioddndustio \Windows Driver be installed? @

<A

Setup will install MOFa Smartiod| ndustio “windows Driver inta the following
folder.

To continue, click Mest. [F you would like to zelect a different falder, click Browse.

| Browse. ..
At least 0.8 MB of free disk space iz required.
< Back |[ Mext = ] | Cancel
4. Click Install to proceed with the installation.
r |
15J Setup - MOXA Smartio/Industio Windows Driver El

Ready to Install

Setup iz now ready to begin ingtalling MOFA Smartiodlndustio Windows Driver on @
wour cormpter.

=4[

Click Install to continue with the installation, or click Back if you want to review or
change any settings.

D estination location; ’
C:AProgram Files\oxaSmartiolndustioD river

< Back |[ [niztall ]| Cancel
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5. Click Finish to complete the installation of the driver.

‘ﬁ_';;r! Setup - MOXLA SrartioIndustio Windows Driver = || =) ER

Completing the MOXA
Smartio/Industio Windows Driver
Setup Wizard

Setup has finished installing MOxS Smartio ndustio \Windows
Diriver on your computer.

Click Finish to exit Setup.

If your model is from the CB Series, then the installation is done. Otherwise, you need to do the following
steps to complete the installation for the CA Series (CA-114 Series is taken as example).

1. Select Add Hardware Wizard from the Control Panel. When the wizard opens, click Next to continue.

Add Hardware Wizard

Welcome to the Add Hardware Wizard

=

Thiz wizard helpz pou;

+ Install software to support the hardware pou add to pour
compter.

* Troubleshoot problems you may be having with wour
hardware.

& If your hardware came with an installation CD,
it iz recommended that you click Cancel to
cloze thiz wizard and use the manufacturer's
CD to install thiz hardware.

To continue, click Mest,

MEHH |[ Cancel
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2. Select Yes, I have already connected the hardware and click Next to continue.

Add Hardware Wizard

Iz the hardware connected?

Hawve pou already connected thiz hardware to your computer?

() Mo, | have not added the hardware yet

¢ Back ” Meut » ][ Cancel

3. Select Add a new hardware device and click Next to continue.

Add Hardware Wizard

The following hardware iz already installed on your computer

Fram the lizt below, select an inzstalled hardware device, then click Hest ta check
properties or troublezhoot a problem pou might be having.

To add hardware not shown in the list, click “4dd a new hardware device."'

Installed hardware:

5%’ Intel(R] 328010DB/0DBM USB2 Enhanced Host Controller - 24C0 -~
&2 USE Root Hub
&2 USE Root Hub
62 USE Root Hub
62 USE Root Hub

Add a new hardware device

¢ Back ” Hest > l[ Cancel
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4. Select Install the hardware that I manually select from a list (Advanced) and click Next to

continue.

Add Hardware Wizard

The wizard can help you install other hardware

The wizard can zearch for other hardware and autormatically install it for paw, Or, if wau
know exactly which hardware model pou want to ingtall, you can select it from a list.

Wwhat do you want the wizard to do’?

() Search for and install the hardware automatically [Fecommended)

< Back ” Heut » l[ Cancel

5. Select Multi-port serial adapters and click Next to continue.

Add Hardware Wizard

From the list below. zelect the type of hardware you are installing

If you do not zee the hardware categony you want, click Show All Devices.

Common hardware types:

Show All Devices
@ Digplay adapters
iZHIDE ATAMATAP contrallers
&#2 |EEE 1394 Bus host controllers
8 [maging devices
,E] Infrared dewvices
E, Maodemnz
=Lk Lilk-port zenial adapters
B b shasrl sdsmbars

¢ Back ” Hest > l[ Cancel
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6. Select your CA Series model and click Next to continue.

Add Hardware Wizard

Select the device driver you want to install for thiz hardware.

Select the manufacturer and model of vour hardware device and then click Mext. IF pou
have a dizk that containg the driver pou want ta install, click Have Dizgk.

b odel ~
MO8 CAT04 Series
MO8 CAT08 Series

A8 CA114 Series
b8 CAT32 Series

& Thiz dnver i1z not digitally signed!

Tell rie why driver signing iz imporkant

v

[ < Back ” Hest > l[ Cancel ]

7. To begin installing the module, click Next.

Add Hardware Wizard

The wizard iz ready to install your hardware

Hardware to install;

S MOMA CAT14 Series

To ztart inztalling your new hardware, click Hest.

< Back | [ Cancel
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8. If you see a warning that the software has not passed Windows Logo testing, click Continue Anyway.

Hardware Installation

L ] 'l_., The zoftware pou are instaling for this hardware:
L
MDA CA114 Senes

haz not pazzed Windows Logo testing to werify itz compatibility
with "Windows =P [Tell me why this testing iz important. |

Continuing your installation of thiz software may impair
or destabilize the comect operation of your sypstem
either immediately or in the future. Microsoft strongly
recommends that pou stop this installation now and
contact the hardware vendor for zoftware that has
pazsed Windows Logo testing.

[ Continue Arnyway ] LETDF'InstaIIatinn |

9. Windows will install the drivers. When the installation has been completed, click Finish.

Copying Files... g]

rsizpart. sys
To C:WwINDOWS hapsterm32A\DRIVERS

Cancel

Add Hardware Wizard

Completing the Add Hardware Wizard

5

The following hardware wasz inztalled:

mﬁ b CA114 Sernies

Windaws haz finizhed installing the software for thiz device.

To close this wizard, chick Finish,

Finizh
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10. After the module has been installed, you will be prompted to install the new serial ports. A Found New

Hardware Wizard window will open for the first serial port, port 0. Select No, not this time and click
Next.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

YWindaws will zearch far current and updated sofbware by
loaking an your computer, on the hardware installation CO, ar on
the Windows pdate Web site [with wour permizsion].

Bead aur privacy policy

Can Windows connect to Windows Update to zearch far
zoftware?

{3 Yes, thiz time only

() Yes, now and gvery time | connect a device

@1

Click Mest o continue.

[ Hest > l[ Cancel

11. Select Install from a list or specific location (Advanced) and click Next.

Found New Hardware Wizard

Thiz wizard helpz you install software for;

kDt communication port

3;';] If your hardware came with an installation CD
2= or floppy disk. inzert it now.

YWhat do you want the wizard to do?

() Install the software automatically [Recommended)
(& install From a list o specific location [Advanced)

Click Mest ta continue.

< Back ” Mest » ][ Cancel
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12. Select Search for the best driver in these locations and Include this location in the search.
Select the \Program Files\MOXA\SmartioIndustioDriver folder on the C drive disk, and click Next.

Found Mew Hardware Wizard
Please choose your search and installation oplions. -E§

(®) Search for the best driver in these locations.

Usze the check boxes below to limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

[] Search removable media (loppy, CO-AOM. )

Include thiz location in the search:

- Browse

() Don't gearch. | will choose the driver to install.

Choose this option to gelect the device driver from a lish. “Windows does not guarantee that
the driver you chooze will be the best match for your hardware:

[ < Back “ Mext » ] [ Cancel ]

13. If you see a warning that the software has not passed Windows Logo testing, click Continue Anyway.

Hardware Installation

L | E The software you are ingtalling for this hardware:;
L
MO Part 0

has not pazzed YWindows Logo testing to werify itz compatibility
with YWindaws =P, [Tell me why thiz testing 1= imparkant. |

Continuing your installation of thiz software may impair
or destabilize the commect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop thig installation now and
contact the hardware vendor for zoftware that has
pazzed Windows Logo testing.

Continue Arnyway ] EéTDF'Installatinn |
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14. Windows will install the necessary drivers.

Found New Hardware Wizard
Pleaze wait while the wizard installs the software. .

(3 b0 Port 0

= L

Setting a spgtem restore point and backing up old filez in
caze your system needs to be restared in the future.

15. After the installation is complete, click Finish.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard haz finished installing the zoftware for;

3 kDt Part 0

Click Finizh to cloze the wizard.

16. Repeat the installation process for the remaining serial ports.
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Configuring the Ports

After the driver has been installed, use Device Manager to configure the serial port of your CA or CB boards
(CB-1341 Series will be used as example).

In this section, we describe how to access MOXA Smartio/Industio Window Driver and lead you to do the
serial port configuration.

m] Accessing MOXA Smartio/Industio Window Driver
a Configuring Serial Port

> Port Number

> Rx, TX FIFO

Accessing MOXA Smartio/Industio Window Driver

Expand the Multi-port serial adapters tab, right-click CB-1341I Series (PC/104-Plus), and then click
Properties to open the board’s configuration panel.

=1 Device Manager EI@

File  Action  View Help

<= @ EHE € &85

4= 3pagd?
-8 Computer

Actions

. . Device Manager on local co.., =
sy Disk drives

o B, Display adapters More Actians ’
1:».'! Floppy disk drives

b -\:H Floppy drive contrallers

«'3” Hurnan Interface Devices

» € IDE ATA/ATAPT cantrollers

... Keyhoards

b 3“_{ Mice and other pointing devices
o Monitars

. Multi-port sevial adapters

: 3 MOXA CB-134] Series (PC/104

8 Network adapters Update Driver Software,.,
AI@ Other dewices Disable

o e[l Unknown device Uninstall

<15 Ports (COM & LPT)

D Processors Scan for hardware changes

IA--I\ Sound, wideo and game controllg
. ey High Definition Audio Device
- Systern dewvices

Properties

+ @ Universal Serial Bus controllers

Opens property sheet for the current selection,
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Configuring the Serial Ports

Port Number

1.

Click the port you would like to configure to highlight it and then click Port Setting.

MDA CB-1341 Series (PCF104-Plus) Properties

General | Ports Configuration |Driver I Detailsl Hesources|

=3

Port | COM Mo, | R« FIFO Lewel | T= FIFO Level
2 COM 2 High High
3 COM 3 High High
4 COM 4 High High
Help
Part Infa
Port Setting
QK. ] l Cancel

Select a COM number for the port from the Port Number pull-down list. Select the Auto Enumerating
COM Number option to map subsequent ports automatically. The port numbers will be assigned in
sequence. For example, if COM 1 is assigned to Port 1, then COM 2 (if not already occupied) will be

assigned to Port 2, etc.

Port1

Part Murber

]9

v Auto Enumerating COM Murnber

R FIFO Lewel |High -

v Setthe change to all ports

Tw FIFO Level |High -

[v Set the change to all ports

Cancel
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Rx, TX FIFO

1. Select an Rx FIFO Trigger from the Rx FIFO Level pull-down list. Rx FIFO trigger levels of High,
Middle, and Low are available, with the default set to High. Select the Set the change to all ports
option to apply this Rx FIFO Trigger to all ports.

2. Select a Tx FIFO Level from the Tx FIFO Level pull-down list. Tx FIFO Levels of High, Middle, and
Low are available, with the default set to High. Select the Set the change to all ports option to apply
the just defined Tx FIFO Size to all ports.

Tx FIFO Rx FIFO

(Byte) (Byte)

CA Series CB Series CA Series CB Series
High 64 128 56 120
Middle 32 64 28 60
Low 1 1 1 1

3. Click OK to save the port settings and then click OK in the Property window to finish the port settings
procedure.

Checking the Status

The PComm Diagnostic program is a useful tool to check the status of Moxa’s multiport serial boards. The
program can be used to test internal and external IRQ, TxD/RxD, UART, CTS/RTS, DTR/DSR, etc. Use this
program to ensure that your Moxa boards and ports are working properly.

To start the program, click Start> Programs-> MOXA-> PComm Ver 1.X2> PComm Diagnostic

Open
@ Internet Explorer (fi4-bit)

@ Internet Explorer

] Windows DVD Maker
555 Windows Fax and Scan
 Windows Media Center
Windows Media Player
7 windows Update

Run as administrator

Troubleshoot compatibility
Open file location

Pin to Taskbar

Pin to Start Menu

o HPS Viewver
J Accessories

Restare previous versions

Send to »

| Games
. Maintenance Cut
J Moxa Copy

, Dsu

| PCarnmm Lite Verl Dl

|E§5) Library Programrming Renarne

|E§5) Library Reference o

5@2 PCamm Diagnostic
_'43 PComm bonitor
ﬂ PComm Terminal Emulator
7 Performance Analyzer

4 Back

Default Prograrms

Help and Support

| Search programs and files

7 AEIEINEIE
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QQ PComm Diagnostic
File Diagnose Help

=] | =| ©|5]

To be tested

CB-134 Series [COMI-COM4)
B Ro-21 108400
PCl bus 1, device 10, function 0

Ready

Select EI i
Select _’I L&

Board Status

CB-134 Series [COM1-COM4)
BB ro-oiiiosa
PCl bus 1, device 10, function 0
Diriver - 1.24 build 1

Total Configuration Boards =1
COM Part &vailable Boards =1

NOTE

You can download the PComm Lite software for free from Moxa’s website at

www.moxa.com/support/free downloads.htm.

Removing the Driver

1.

Open the Device Manager and use the mouse to place the cursor over the MOXA CB-1341I Series

(PC/104-Plus boards) under Multi-port serial adapters, right-click, and then select the Uninstall

option.

.
=y Device Manager

File  Action Miew Help

& | @ E HE E B %S

(=)o /=

4=y Iphgd?

> {8 Computer

< Disk drives

B Display adapters

<y Floppy disk drives

b == Floppy drive controllers
":":“-J Hurnan Interface Dewvices
» g IDE ATAATAPT contrallers
p &2 Keyboards

P Mice and other pointing devices
- Monitors

S Multi-port serial adapters

| S

¥ Netwark adapters
Other dewvices
i Unknown device
15T Parts (COM & LPT)
D Processors
Q--J\ Sound, video and game contrallers
4y High Definition Audio Device
M System devices
b - Universal Serial Bus controllers

Uninstalls the driver for the selected dewvice,

" MOXA CB-134] Series (PC/104-Plus)

Update Driver Softusare...
Disahle

Uninstall
Scan for hardware changes

Properties

2. Select Delete the driver software for this device and click OK to proceed with uninstalling the board.
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Uninstallating the Driver

The MSB driver may be removed through Add/Remove Programs in the Windows Control Panel. Click
Uninstall next to MOXA Smartio/Industio Windows Driver Verx.xx

I ey

@lem » Contral Panel » All Control Panellterns » Programs and Features » Moxa Inc. - ‘ gy | | Search Programs and Fzaturss pel |

Control Panel Home .
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

¥ Tum Windows features on or

et Organize » Uninstall >~
Marme Uninstall this program. Publisher < Installed On Size Wersion
=D Ver2, 1 boxa Inc, 1182017 165 ME
= MAOKA Srmartio/Industio Mindows Driver Verl.24 Moxa Ine, 1312017 124
@ MPartWindows Driver Manager o Inc, 171842017 113
= PCarnm Lite Yerlf Moxa Inc, 1972017 452 MEB
4 m b
3l MoxaInc. Product version: 1.24 Suppert link: http://www.moxa.com
|' Help link: http:/fwww.moxa.com Update information: http://www.moxa.com
@-uvh"ﬂ' v Control Panel » &l Control Panel terns » Programs and Features » hoxa Inc, - |47 | | Search Programs and Fegtures 2 |
Control Panel Home .
Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair,
#y Turn Windows features on or
ot Organize v Uninstall (]
Name : Publisher o Installed On Size Wersion
m7]DSU Ver2.1 Moxa Inc, 1/18/2017 165 MEB
B bAOXA Smartio/Industio Windows Driver Verl.24 toxa Inc, 173172017 14
@NPDmedows Driver banager Moxa Inc, 171872017 113
rACER Srartio/Industio Windowes Driver Uninstall E3 i 2t ALl
b Are you sure youwrant to completely remove MOXA SmartiofIndustio
Windows Driver and all of its compaonents?
Yes I I Mo
] m b
1| Moxalne Product version: 1.24 Support link: hitp://www.moxa.com
|' Help link: http://www.moxa.com Update information: http://www.moxa.com
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o || B[
@'\le“:h v Control Panel » All Control PanelIterns » Programs and Features » Moxa Inc, - |6¢ | 5earch FPrograws ond Features ol
Control Panel Home .
Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.
) Turn Windows features on or
=i Organize + Uninstall =~ [ -g-
Marre ° Publisher o Installed On Size Wersion
=1 DSU Wer2 1 Muoa Inc, 171872017 1.65 MB
= MO Srnartiondustio Windows Driver Verl 24 Muoxa Inc, 13172017 124
& HPart Windos Driver Manager Moa Inc. 1/18/2017 119
ROXA SmartiofIndustio Windows Driver Uninstall @ Loz SRl
I . ;MO Smartio/Industio Windows Driver was successfully removed
LW from your computer.,
] m »
. 73| Moxa Inc Product version: 1.24 Support link: http://www.
Help link: http://www.moxa.com Update information: http://www.moxa.com

Non-Windows OS

Linux

1. Execute the following commands from the Linux prompt:

#cd /

#mkdir moxa

#cd moxa

#cp /<driver
directory>/driv_linux_smart_<version>_build_<build_date>.tgz .

# tar —zxvf
driv_linux_smart_<version>_build_<build_date>.tgz# #cd mxser

2. #cd /moxa/mxser/driver

#./mpmknod

3. Install the module driver using the hardware settings that you selected. For example, for an I/O address
of 0x180, an INT vector of 0x1CO, and an IRQ of 10, execute the following command:

#modprobe mxser ioaddr=0x180 iovect=0x1CO0 irq=10
(This step is only for CA Series)

4. You can use the Moxa diagnostic utility to verify the driver’s status:
#cd /moxa/mxser/utility/diag
#./msdiag

5. You can use the Moxa terminal utility to test the TTY ports:

#cd /moxa/mxser/utility/term
#./msterm
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Serial Programming Tools

Moxa provides Windows serial programming libraries and troubleshooting utilities that are easy to use and
powerful. You can use these tools to reduce software development time.

The serial communication library is useful for developing applications for data communications, remote
access, data acquisition, and industrial control. It provides a simpler solution compared to the more complex
Windows Win32 COMM API.

PComm is a professional serial communication tool for Windows PCs. PComm includes the following
features:

e Useful utilities for diagnostics, port monitoring, and terminal emulation

e Sample programs

e Comprehensive help files
The following topics are covered in this chapter:

O Serial Programming Library
O PComm Utilities

» Installation

» PComm Diagnostic
» PComm Monitor
>

PComm Terminal Emulator
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Serial Programming Library

The serial programming library assists you in developing serial communications programs for any COM port
that complies with the Microsoft Win32 API. It facilitates the implementation of multi-process and multi-
thread serial communication programs and can remarkably reduce development time.

The library provides a complete set of functions as well as various sample programs for Visual C++, Visual
Basic, and Delphi. To view detailed descriptions of the available functions and sample programs, go to Start
- Program > PComm Lite and select PComm Lib Help, PComm Porting Notes, or PComm
Programming Guide. You may also refer to the sample programs in the PComm directory.

PComm Utilities

This sections provides brief descriptions of the PComm utilities. For more information about these utilities,
please refer to the help files or to the API-232.txt file for DOS.

Installation

To install PComm, run Setup.exe from the installation diskette. Please note that the PComm diagnostic and
monitor utilities are for Moxa boards only. These two utilities will not work with other serial boards.

PComm Diagnostic

PComm Diagnostic is designed for Moxa boards only. It provides internal and external testing of IRQ,
TxD/RxD, UART, CTS/RTS, DTR/DSR, DTR/DCD, and other items. You can use PComm Diagnostic to check
the operation of both software and hardware.

To run the Diagnostic program, go to Start > Program - PComm Lite > Diagnostic.

W L o))
= | = &5
Tobe tested... S
“ CA114 Series(4 ports] [COM3-COME] EI . .
| IRG=101/0=1C0 Select [Config) to set test option

Select ’l [Go) to start testing

Board Status

CA114 Series(4 ports] [COM3-COME]
B ro-ovooioo
Dirivver :

Ready

Total Configuration Boards = 1
COM Port Available Boards = 1

_
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PComm Monitor

PComm Monitor is designed for Moxa board in Windows NT only. It allows you to monitor data transmission
of selected Moxa COM ports. It monitors data transmission, throughput, and line status at regular intervals.
Click on a specific port to view that port’s communication parameters and status.

To run PComm Monitor, go to Start > Program > PComm Lite - Monitor.

2+ PComm Monitor

=1ES

COMI Port Status

Port Count/Tx  CP§/Tx Count/Rx CP§/Rx RT3 CT3 DTR DSR DCD

oM 126976 1024 125264 1010 @ @ =
coMa 126378 10z4 128976 1024 @ @

oS 125352 1015 126760 lozz @ @

coMe 125952 1015 126300 1018 @ @

com? 125952 1015 126032 1016 @ @

coms 128000 1032 125828 1014 @ @

126976 125648
oML 126378 l0z4 125440 1011 @ @
oMl 0 0 0 0 @ @

R [bytes/1g]— [~ Fx Histary

[x]
— Tw[bytes/1g)— [ T= History

| Port Name COMS | | Paort Status Dpen |
Communication Parameter HAw Flow Control A SR EIREEREA
eraud Riate (bps) 38@ ’7F|TS Flaw Control oy | [EPSed Tine:00:0a
Diata Bits g CT5 Flove Cantrol oM

PComm Term

inal Emulator

PComm Terminal Emulator can be used to connect to a serial port to verify that data transmission is
functioning correctly. It supports multiple windows and both VT100 and ANSI terminal types. You can
interactively transfer data, periodically send patterns, and transfer files using ASCII, XMODEM, YMODEM,
ZMODEM, and KERMIT protocols.

To run PComm Terminal Emulator, go to Start > Program > PComm Lite > Terminal Emulator.

£ PComm Terminal - COM44,38400.Mone.8,1.Dumb Teminal

File Edit Port Manager Port

Window Help

2 BK| Bz S
= =

DTR |Pazsword:

ou have mail [gTR
TERM = (ansi [grs
£ lc

profile

Iin

oot

E3

L4l |
State:DPEN [ [=

xenix386!login: root

E¥ COM44,38400,None, 8,1 Dumb Terminal

[ [0122456787abade £5hi30123456 705 abode tghi 10123456785 abode tghi 01234

Telcome to SC0 XENIX Syscem W

012345678%abede fyhii0123456739 ahode fol 123456789ahcde fyhiinlzs
01224E678%abode fuhi 01223456789 ahode fahi J01234E678%ahode fuhi 10123
01z345672%abodefghij0lZ345678%abodefghij012346678%abode fghij0123
012345673%abodefghij0lZ345678%abode fghij012345678%abodefghij0123
012345678%abode fyhii0lZ345678%abode fohij012345678%bode fghij0123
012345678%abode fuhii0l2345678%abode fohi J012345678%abode fghi 0123
012345678%abode fyhii0123456789ahode fahiJ012345678%ahode fuhi 10123
[012245678%abode fyhi j0122456789abode fghi J01234E678%abode fahi 10123
012345673%abode fghij01Z345678%abode fghi 012345678 %abode fghij0123
012345673%abodefghij0lZ345678%abode fghij012345678%abodefghij0123
012345678%abode fyhii0lZ345678%abode fghi012345678%abocde fghij0123
012345678%abode fyhii0123456789ahode fahiJ012345678%ahode fuhi 10123

01224E678%abode fuhi j012245673%9abede £

01224E678%abode fuhij0123456789ahode fahi J01234E678%ahode fuhi 10123,
-
3

1

BtateOPEN 52 [5 [= [ | v |
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Smartio/Industio Programming Guide

If you want to develop your own driver, no matter whether it is on a Windows or Linux platform, Moxa
Smartio/Industio Programming Guide is very useful.

The following topics are covered in this chapter:

Relative Product List

Resource Requirement for Moxa Board

PCI Configuration for Moxa Board

UART Register Structure for MU860 chip

UART Register Structure for MUE250, MUE450, and MUE850 chips
For Baud Rate Setting

Moxa Board PCI Device ID List

UART Datasheet

aaoaoaaogaaaoaa
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Smartio/Industio Programming Guide

Relative Product List

Please see the “"Moxa Board PCI Device ID List” at the end of this document.

Resource Requirement for Moxa Board

IRQ * 1

1/0 :

UART register: 64 bytes (8 bytes/port * 8port) for MU8S60

4096 bytes (512 bytes/port * 8port) for MUE250/450/850

IRQ Vector register:16 bytes (only 1 byte is used)

PCI Configuration for Moxa Board

A. MOXA Vendor ID: 0x1393

B. Device ID: Please see the “Moxa Board PCI Device ID List” section

C. Hardware resources on the Device Configuration Register of the PCI configuration space:

Resource Name Chip Address Offset Size
IRQ All 0x3C

IRQ Vector Address MU860 0x1C BAR3 16 bytes
UART register MU860 0x18 BAR2 64 bytes
(I/0 Base Address)

UART register MUE250, MUE450, MUE850 0x14 BAR1 4096 bytes
(Memory Base Address)

Vector Base Address MUE250, MUE450, MUES50 0x18 BAR2 16 bytes
Byte Offset 0-7 8-15 16-23 24-31

00h Vendor ID Device ID

04h Command Status

08h

0Ch

10h BARO

14h BAR1

18h BAR2

1Ch BAR3

3Ch Interrupt Line Interrupt Pin Reserved

NOTE For MUE250, MUE450, and MUE850 chips only:
Memory mode is recommended for these chips to access UART. To use memory mode, the driver has to

access the memory base address, which is located at BAR1.
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UART Register Structure for MU860 chip

|—————  Total64 bytes  —
[ Bbytes| Bbotes [ ... [ |
lztports  Z2nd ports Bth port's
ULART TART .. UART
megister  register register
TART register, 8 butes for each port
[ Thyte] I byt | [ - [ |

lsfgjste 2nd ath

e Iy e gizter, i

RER/THR  IER ol

NOTE For a detailed UART register description, please see the "UART Datasheet” section..

e UART register address = I/0 base address + (port-1) *8

For example, if the base address is 0x180:

The first port’s UART registered I/O address is 0x180+(1-1)*8 = 0x180
The first registered I/O address is 0x180,
The second registered I/0 address is 0x181,

The second port’s UART registered I/O address is 0x180+(2-1)*8 = 0x188
The first registered I/O address is 0x188,
The second registered I/0 address is 0x189, ...

e IRQ Vector Register Structure

|— Total 1 byte (8 bits) I

[ 1hit | Ibit | | 1bit |
bif7: 8th poit bith: Tth port bifl) ; 1th port
Bit Value Status
0 Interrupt pending. Please read the UART register to get the detail interrupt

information *.

1 No interrupt pending.

All serial ports on the same Moxa board use the same IRQ. Check the vector to determine which port
issues the interruption. You can also get the information by querying the IIR of each port.
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UART Register Structure for MUE250, MUE450,
and MUES850 chips

There are 512 bytes for each UART register and 0x200 offset between each port. However, there is one
exception, for the models which are 4-port boards, such as CP-104EL-A, CP-114EL, CP-114EL-I, and CP-
134EL-A, the offset of the fourth UART register is 0xE0O.

UART Register Offset

0000h
UARTO Registers

02000
UART1 Registers

0400n |
UARTZ2 Registers

0600
UART3 Registers

0800h UART Register Offset

i 0000h
_| UART4 Registers UARTO Registers
0ADOR | ] e
_ UARTS Registers UART1 Registers
0coon . 04008
UART® Registers UART2 Registers
0EDOh . OEDOR )
UARTY Registers UART3 Registers
Registers for 8 ports Registers for 4 ports

NOTE

For a detailed UART register description, please see the "UART Datasheet” section..

e UART register address = 1/0 base address + (port-1) * 0x200

For example, if base address is 0x200:

The first port’s UART registered I/O address is 0x200 + (1-1) * 0x200 = 0x200
.................. The first registered I/0 address is 0x200,
The second registered I/0 address is 0x201, .....

The second port’s UART registered I/0 address is 0x200 + (2-1) * 0x200 = 0x400
The first registered I/0 register is 0x400,
The second registered I/0 register is 0x401, .....

NOTE

For CP-104EL-A, CP-114EL, CP-114EL-I, and CP-134EL-A only:

The first port’s UART registered address: I/O base address

The second port’s UART registered address: I/O base address + 1 * 0x200

The third port’s UART registered address: I/O base address + 2 * 0x200

The fourth port’s UART registered address:I/O base address + 7 * 0x200Type note content here.
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e Control Serial Interface and Termination Resistor for MUE chips
For Moxa boards that use MUE250, MUE450, and MUE850 chips, BAR2, which is allocated 16 bytes. is
the vector base address that can be used to control the serial interface and termination resistor
according to the following table.

Offset Bit Port # Parameters
Ox4 [3..0] 1 0x0 : RS-232
[7..4] 2 0x1 : RS-422
0x5 [3..0] 3 OxF : RS-485 2W
[7..4] 4 OxB : RS-485 4W
0x6 [3..0] 5
[7..4] 6
0x7 [3..0] 7
[7..4] 8
0x8 [7..0] [8..1] GPIO - Input
0x9 [7..0] [8..1] GPIO direction configuration
0 : Set GPIO direction to input
1 : Set GPIO direction to output
OxA [7..0] [8..1] GPIO - Output (Termination Resistor)
0 : Low (0 Ohm)
1 : High (120 Ohm)

Especially, the interface of 4-port models, such as CP-114EL and CP-114EL-I, is using the following
offset to set the interface of port 4.

Offset Bit Port # Parameters
Ox4 [3..0] 1 0x0 : RS-232
[7..4] 2 0x1 : RS-422
0x5 [3..0] 3 OxF : RS-485 2w
[7..4] - 0xB : RS-485 4W
0x6 [3..0] -
[7..4] -
0x7 [3..0] 4

For Baud Rate Setting

For General PC Com Port: CLK=1.8432MHz
Div = CLK/(Baud x 16)
But for Moxa Board: CLK=14.7456MHz

Div = CLK/(Baud x 16)
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Moxa Board PCI Device ID List

Model Ports Bus Chip Max Baud Vendor ID |Device ID
CP-102U 2 UPCI MU860 921.6k 0x1393 0x1022
CP-102UL 2 UPCI MU860 921.6k 0x1393 0x1021
CP-132UL 2 UPCI MU860 921.6k 0x1393 0x1321
CP-132UL-I 2 UPCI MU860 921.6k 0x1393 0x1321
CP-102E 2 PCle MUE250 921.6k 0x1393 0x1024
CP-102EL 2 PCle MUE250 921.6k 0x1393 0x1025
CP-132EL 2 PCle MUE250 921.6k 0x1393 0x1322
CP-132EL-I 2 PCle MUE250 921.6k 0x1393 0x1322
CP-104UL 4 UPCI MU860 921.6k 0x1393 0x1041
CP-104JU 4 UPCI MU860 921.6k 0x1393 0x1042
CP-114UL 4 UPCI MU860 921.6k 0x1393 0x1143
CP-114UL-I 4 UPCI MU860 921.6k 0x1393 0x1143
CP-134U 4 UPCI MU860 921.6k 0x1393 0x1340
CP-134U-1 4 UPCI MU860 921.6k 0x1393 0x1340
CP-104EL-A 4 PCle MUE450 921.6k 0x1393 0x1045
CP-114EL 4 PCIe MUE450 921.6k 0x1393 0x1144
CP-114EL-I 4 PCIe MUE450 921.6k 0x1393 0x1144
CP-134EL-A 4 PCle MUE450 921.6k 0x1393 0x1342
CB-114 4 PC/104-Plus MU860 921.6k 0x1393 0x1142
CB-1341 4 PC/104-Plus MU860 921.6k 0x1393 0x1341
CP-118U 8 UPCI MU860 921.6k 0x1393 0x1180
CP-118U-I 8 UPCI MU860 921.6k 0x1393 0x1180
CP-138U 8 UPCI MU860 921.6k 0x1393 0x1380
CP-138U-1 8 UPCI MU860 921.6k 0x1393 0x1380
CP-168U 8 UPCI MU860 921.6k 0x1393 0x1681
CP-116E-A(A) 8 PCle MUES850 921.6k 0x1393 0x1160
CP-116E-A(B) 8 PCIe MUES850 921.6k 0x1393 0x1161
CP-118EL-A 8 PCle MUES850 921.6k 0x1393 0x1182
CP-118E-A-I 8 PCle MUE850 921.6k 0x1393 0x1183
CP-138E-A-I 8 PCle MUES850 921.6k 0x1393 0x1381
CP-168EL-A 8 PCle MUES850 921.6k 0x1393 0x1683
CB-108 8 PC/104-Plus MU860 921.6k 0x1393 0x1080

UART Datasheet

Moxa’s chips are compatible with the following chips. For more details about the UART register description,
please refer to the downloaded links below.

UART Port Datasheet
MU-860 2-8 TL16C550C
MUE-250 2 PI7C9X7952
MUE-450 4 PI7C9X7954
MUE-850 8 PI7C9X7958
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Pin Assignments

The box header connector(s) on the module is used to connect to serial devices. Optional cables are
available that provide DB9 or DB25 connectors. The pin assignments of the box header connectors and
available cables are provided below.

Box Header Pin Assignments

RS-232

These pin assignments apply to the CA-108/CB-108, CA-114/CB114, and CA-104. Note that there are two
40-pin box header connectors on the CA-108/CB108, each of which connects to 4 serial ports.

Pin Signal Pin Signal Pin Signal Pin Signal
1 DCDO 11 DCD1 21 DCD2 31 DCD3
2 DSRO 12 DSR1 22 DSR2 32 DSR3
3 RxDO 13 RxD1 23 RxD2 33 RxD3
4 RTSO 14 RTS1 24 RTS2 34 RTS3
5 TxDO 15 TxD1 25 TxD2 35 TxD3
6 CTSO 16 CTS1 26 CTS2 36 CTS3
7 DTRO 17 DTR1 27 DTR2 37 DTR3
8 - 18 - 28 - 38 -

9 GNDO 19 GND1 29 GND2 39 GND3

10 - 20 - 30 - 40 -

RS-422, 4-wire RS-485

These pin assignments apply to the CA-132, CA-1321 , CA-114/CB-114, and CA-1341/CB1341. With regard
to the CA Series, pins 21 to 40 apply to the CA-114 and CA-134I only.

Pin Signal Pin Signal Pin* Signal* Pin* Signal*
1 TxDO0-(A) 11 TxD1-(A) 21 TxD2-(A) 31 TxD3-(A)
3 TXDO+(B) 13 TxD1+(B) 23 TxD2+(B) 33 TXD3+(B)
5 RxDO+(B) 15 RxD1+(B) 25 RxD2+(B) 35 RxD3+(B)
7 RxDO-(A) 17 RxD1-(A) 27 RxD2-(A) 37 RxD3-(A)
9 GNDO 19 GND1 29 GND2 39 GND3
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Pin Assignments

2-wire RS-485

These pin assignments apply to the CA-132 , CA-1321, CA-114/CB-114, and CA-1341/CB-1341. With regard

to the CA series, pins 21 to 40 apply to the CA-114 and CA-134I1 only.

Pin Signal Pin Signal Pin* Signal* Pin* Signal*
DataO+(B) 15 Datal+(B) 25 Data2+(B) 35 Data3+(B)
Data0-(A) 17 Datal-(A) 27 Data2-(A) 37 Data3-(A)

GNDO 19 GND1 29 GND2 39 GND3
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